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 1 
OBJECTIVES 

This part is to introduce you to the Road Project Manager and to the basic Road tools provided by 
GEOPAK.  The Road Project Manager allows you to select a Project which automatically sets the 
location of the GPK file and working directory.  The Road tools enable you to familiarize yourself with 
the Project basic geometry information; the geometry that will be used during the modeling process, 
the Super Elevation information and to analyze the data stored within the GPK file (Chains).   

ROAD PROJECT MANAGER 
Project Manager is a GEOPAK tool that associates a project with its respective coordinate geometry 
job number, users, working directories and project files. 

ACCESSING PROJECT MANAGER 

OPEN A BRIDGE DESIGN FILE AND SELECT THE ROAD PROJECT MANAGER 

 Open Bridge3D.dgn 

Open file C:\DATA\GEO\VDOT\Bridge\ BasicRoadToolsToKnow\ Job200Bridge3D.dgn. 

To access Project Manager, select (MicroStation: Applications> GEOPAK ROAD>GEOPAK ROAD 
Tools) or (MicroStation: Applications>GEOPAK BRIDGE>Road Tools).  Select the road Project 
Manager icon.  The Project Manager dialog appears. 

 Select the Road Project Using the Road Project Manager 

1. Select the Road Project Manager tool.  The Project Manager dialog box appears. 

                                              

 

Basic Road Tools to Know 

 



Open a Bridge design file and Select the Road Project Manager 
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The current directory is displayed at the top of the dialog box.  This may be modified by traversing to a 
different directory in the Directories list box.  

2. Under the Directories list box, select C:\DATA\GEO\VDOT\BRIDGE. 

 The Projects list box shows the available projects: 

    

3. Under the Projects list box, select Road Tools.prj.  . 

Note Record in your manual the Job Number displayed in the middle of the dialog box.   

4. Click OK button to continue.  

Note To exit Project Manager click the Cancel button 

5. The Project Users dialog box appears. 

 

6. Select your name from the list of user.  If your name is not available, contact your project 
administrator 

7. Click OK to continue.  The Road Project dialog box appears. 



Open a Bridge design file and Select the Road Project Manager 
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The top of the dialog displays the Working Directory, User and GEOPAK Job Number.. 

 

The small square in the upper right corner will condense the dialog as depicted in the graphic below. 

 

Note Use the Road Project Manager each time before you start a new session with GEOPAK 

8. Minimize the Road Project dialog box. 



Basic Road Tools 
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BASIC ROAD TOOLS 
Two tools that you will be reviewing are: 

 The Navigator tool:  This tool is located in the Coordinate Geometry dialog box. 

 The Shape Properties and the Shape Analyst:  These tools are located in the Superelevation 
Shape Manager tool palette. 

 Starting GEOPAK Bridge> Road Tools 

1. Select GEOPAK BRIDGE (MicroStation: Applications>GEOPAK BRIDGE>Road 
Tools). 

 

The GEOPAK Road Tools palette appears. 

 

 



Accessing the Coordinate Geometry Dialog Box 
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ACCESSING THE COORDINATE GEOMETRY DIALOG BOX 

 Open the COGO Geometry Dialog Box 

1. Select the COGO tool from the GEOPAK Road tools palette. The Coordinate Geometry 
dialog to select a Job Number appears. 

     

2. Select the Select GPK File tool.  The Job Number: dialog appears. 

 

3. Select job200.gpk from the list. 

4. Click OK to proceed. The Coordinate Geometry updated dialog appears. 

 

5. Click OK to proceed.  The Coordinate Geometry dialog appears as shown below: 

 

 

 



The Navigator 
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THE NAVIGATOR 
The Navigator is a basic tool used to review the data already stored in a GPK file (CHAINS). The 
Navigator is used to visualize graphically Chains, Points and Curves etc.  

When more specific information is required by the designer, the Navigator also provides Utility tools 
to allow for Describing the component. 

The tools that will be reviewed in this chapter are: 

 Visualize Element 

There are two methods to visualize components:  

 Permanently (Permanent Visualization) by drawing the components in the DGN file 

 Temporarily (Temporarily Visualization) by displaying the component in the DGN file.   

Temporarily visualized elements can be cleared from visualization at any time by selecting one of the 
options available in the Tools pulldown list.  

 

 

 Print/Describe Element 

 The Elements pull down list 

 

 

 

 



The Navigator 

 

VDOT Bentley Bridge Training Manual 2004 Edition 
6/8/2006  1-7                                                         

 Visualization 

1. From the Visualization pull down list, select Temporary Visualization. 

 

2. Select the Navigator tool, from the Coordinate Geometry dialog. The Navigator (200) dialog 
appears. 

 

3. From the Elements pull down list, select Chain. The available Chains in the current GPK file 
appear in the list. 

 

4. Select 200-RTE637 Chain. 

5. Select the Visualize Element tool.  Notice that the Chain appears in the DGN file. 

6. Select the MicroStation Fit View tool. 

7. From the Navigator Menu, select Tools > Clear Visualized Elements (Temporary) option. 

8. Close the Navigator dialog.  Click on the X located on the Top Right Corner of the dialog. 
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 Describe Chain Element 

1. From the Coordinate Geometry dialog, select the Navigator tool. The Navigator (200) dialog 
appears. 

2. From the Elements pull down list select Chain. The available Chains in the current GPK file 
appear in the list. 

 

3. Select 200-RTE637 Chain from the list. 

4. Select the Print/Describe Element tool. Notice that the Coordinate Geometry dialog shows 
all of the information related to the selected element. Use the Scroll bar to review the data. 

 

5. Close the Coordinate Geometry dialog box. Click on the X located on the Top Right Corner 
of the dialog.  The Alert Box appears. Click No to proceed. 
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THE SHAPE MANAGER  
The tools described in this part are the Shape Properties and the Shape Analyst. 

The Shape Properties:  This tool is used to extract the attributes from a GEOPAK Shape.  
Automatically these attributes are displayed in the Shape Properties dialog box as shown below; 
The Baseline, Profile, Tie, From Slope, To Slope and Class.  You should review this information 
to get familiar with the GPK information Bridge will be utilizing to calculate Z-Levels. 

  

The Shape Analyst:  The Shape Analyst can be used to visualize graphically the information that 
is calculated at anywhere within the Bridge Model; Chain, Profile, Station, Offset to the indicated 
point from the Chain, Elevation, PGL Elevation, PGL Slope, Cross Slope, Longitudinal Slope and 
the Flow Slope. 

Note The Display Only option allows the user to view graphically the Elevations values temporarily. 
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  Shape Properties 

1. Select the Shape Manager tool from the GEOPAK Road Tools. 

 

2. Select the Shape Properties tool from the Superelevation Shape Manager tools palette. 

 

The Shape Properties dialog appears. 

 

 

3. Enable the Baseline, Profile, Tie, Class, From Slope and To Slope options. The dialog 
changes. 

 

4. Click on the ID push button. 
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5. Indicate a Data Point inside of the Circle 1, touching the shape element. Accept the 
selection. The Shape Properties changes as shown below. 

 

6. Indicate a Data Point inside of the Circle 2, touching the shape element. Accept the 
selection. The Shape Properties changes as shown below. 

 

 Shape Analyst  
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1. Select the Shape Manager tool from the GEOPAK Road tools palette. 

  

2. Select the Shape Analyst tool from the Superelevation Shape Manager Tools palette. 

 

The Shape Analyst dialog appears. 

 

3. Select Job number. Select the Select GPK File tool. Select job200.gpk from the list. 

 

4. Click OK to proceed.  

 

5. Enable the Display Only option. 

6. Click the DP button. Proceed to indicated DP data points as shown below. Notice the values 
displayed in the dialog. 
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The Shape Analyst dialog shown below displays all the information related to the Indicated point 1. 

 

    

 
Shape Analyst and information for Point 1 Shown 

7. Close the Shape Analyst dialog by Clicking on the X located on the Top Right Corner of the 
dialog. 
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 2 
OBJECTIVES 

In this part you will learn the basics of how to create a Bridge Model.  GEOPAK Bridge allows you to 
create Models using simple to complex alignments.  

STARTING BRIDGE 

 Open Bridge3D.dgn and Attach Shapes.dgn file as Reference  

This SHAPES.DGN contains all the information required to calculate elevations (Z Levels); 
Profile and Cross Slope information along the Bridge. 

1. Open Bridge3D.dgn file (C:\DATA\Geo\VDOT\Bridge\ Training\Bridge3D.dgn) 

2. Select References tool from the MicroStation Primary Tools. 

Note For additional information related to Using References, see MicroStation On-Line Help. 

3. Select Attach Reference tool. 

4. Select C:\DATA\GEO\VDOT\BRIDGE\TRAINING\Shapes.dgn.  Click OK to proceed. 

 

5. Enter for Logical Name Shapes. 

 

6. Click OK. 

7. Close the References dialog box.   

 

   Job520 Bridge 



Starting Bridge 
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 Select the Road Project Using the Road Project Manager 

1. Select the Road Project Manager tool. The Project Manager dialog box appears. 

2. Under the Directories list box, select C:\DATA\GEO\VDOT\BRIDGE. 

3. Under the Projects list box, select Training.prj.  The Project Users dialog box appears. 

Note Record in your manual, the Job Number shown in the dialog. 

4. Under the Project Users list box select your name from the list of users. 

Warning If your name is not available, contact your project administrator. 

5. Click OK to continue. 

6. Minimize the Road Project dialog box. 

 Check the Shapes Data and Record the CHAIN name 

1. Select GEOPAK BRIDGE (MicroStation: Applications>GEOPAK BRIDGE>Road 
Tools). 

 

2. Select the Shape Manager tool from the GEOPAK Road tools palette. 

 

3. Select the Shape Analyst tool from the Superelevation Shape Manager Tools palette.  The 
Shape Analyst dialog appears. 

4. Enable the Display Only option. 

5. Click the Dynamic button. Proceed to indicated DP and move the mouse cursor within the 
shapes area. Notice the values displayed in the dialog 

Note Write in your training manual, the name of CHAIN that appears in the Chain pull down list.  
You will make references to this chain later in this chapter. 
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 Selecting GEOPAK BRIDGE 

1. Select GEOPAK BRIDGE (MicroStation: Applications>GEOPAK BRIDGE>Modeling). 

 

Note If the database is not available, a new database is created. 

 

2. Click OK to proceed. 

3. Select VDOT_M from the Configuration Folder list. 

 

4. Select Metric (m) from the Units pulldown list. Click OK to proceed. 

Note An Information box appears informing that a Default Bridge database is created.   

5. Click OK to proceed. The Bridge tools palette appear as shown below. 

   
Bridge Tools palette shown   
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MODELING WORK FLOW 
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CREATING A NEW BRIDGE 
The Bridge Project Manager enables the user to add, delete, and modify bridges within the current 
project.  At the beginning of a project, the list box in the center of the dialog is blank. As bridges are 
created, they are added to the list. To modify or review a bridge, simply highlight the line, then use the 
action buttons on the right side.  Several bridges may be defined within each project, and the user may 
work on all as he selects.  

Bridges are created in the Bridge Project Manager by selecting the Create Bridge tool or by right 
mouse click anywhere within the Bridge tree list.  Then, after the Pop-up menu appears, select the New 
> Item option. 

Additional tools are available on the right side of the dialog: Redesign a bridge, Reload configuration 
parameters and Create a Template Database in the current Configuration Folder.   

 Create a new Bridge 

TOOL DESCRIPTION 

 
Project Manager 

 

1. Select the Project Manager tool from the GEOPAK Bridge tools palette. 

 

2. Right mouse-click anywhere within the Bridge tree list.  Select New > Item.   

Note Another way to create a Bridge is to select Create Bridge tool.  This tool is located in the right 
side of the dialog. 

3. The Name and Description Editor: Bridge dialog appears.   

 

4. Enter Name East. 

5. Click OK to proceed. 
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USING BRIDGE ON-LINE HELP 
There are two options to start up the Bridge On-Line help. 

•  Selecting MicroStation Main Menu: (Applications > GEOPAK >BRIDGE > Help) 

•  Selecting the keyboard Function Key assigned to Help. 

Note Check which Function Key in your Keyboard is assigned to Help.  The Key assignment varies 
from User to User. 

 Check the Function Key Assigned to Help 

1. Select MicroStation Main Menu: Workspace > Function Keys…  The Function Keys dialog 
appears.  In the capture shown below the function key F2 is assigned to Help.  Take note of 
the Function Key you need to use in the next exercise. 

 

2. Click Cancel to close the dialog. 

 Use the Bridge Help 

1. Click anywhere within the GEOPAK Bridge - Project Manager Dialog box. 

2. Select the Function Key from your keyboard that is assigned to Help.  The Bridge On-Line 
Help opens and displays the information of the specific active dialog. 

 

3. Review the information.  Close the Help dialog. 

4. Close the Project Manager Dialog box by clicking on the X located in the Right upper corner. 
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CREATE BRIDGE SURFACES 
GEOPAK Bridge calculates Elevations (Z Levels) by making reference to surfaces using the following 
methods: 

 GEOPAK Shapes (DGN file Shapes.dgn needs to be Referenced in the Bridge DGN file) that are 
identified by Job Number and CHAIN or a Bridge Alignment  

 GEOPAK DTM (TIN file needs to be available) 

 Top-side of Deck Component (Deck already placed in the model) 

 Bottom-side of Deck Component 

 Combined Selected Surfaces.   

Surfaces are created in the Surface Manager by selecting the Surface Manager tool.  At the beginning 
of a project, the list box in the center of the dialog is blank. As Surfaces are defined, they are added to 
the list.   

Once the Surface Manager dialog appears, proceed to select the Surfaces folder.  This action forces the 
dialog to expand showing the Surface Data that is required to register a Bridge Surface.  After the 
Surface Data is defined, select the Create Surface tool or Right Mouse click anywhere in the Bridge 
tree list to select New Item. 

The Display Z Levels tool in the Surface Manager, allows the user to verify the validity of the surface 
by displaying elevation (Z Levels) values.  The procedure is to first select the Surface from the Bridge 
tree list. The second step is to select the Display Z Levels tool and the third step, you nee to move the 
cursor anywhere in the design file.  Bridge will display the Elevation, also the location of the point 
relative to the Shape; Bridge displays if the point is Inside or Outside of the Surface. 

When all the surfaces are created, the Surface Manager dialog appears as shown below. 

 
           Final Surface Managers dialog shown 
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 Register “EBWB Shape” Surface (Bridge Riding Surface) 

TOOL DESCRIPTION 

 
Surface Manager 

 
Display Z Levels 

 

1. Select the Surface Manager tool from the GEOPAK Bridge tools palette.   

The Surface Manager dialog appears. 

         

                     GEOPAK Bridge – Surface Manager: East dialog shown    

2. Select the Surfaces folder.  The dialog expands. 

           
                               GEOPAK Bridge – Surface Manager: East expanded dialog shown 

Under the Surface Data group box: 

         

3. Select GEOPAK Shapes (Job and Chain) from the “Create By” pulldown list. 

4. Click Browse to select the location of the Job file. Select 
C:\DATA\GEO\VDOT\BRIDGE\TRAINING  

5. Select Job520. 
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6. Select ML1 from the Chain pulldown list. 

7. Right mouse-click anywhere within the Bridge tree list.  Select New > Item.   

8. The Name and Description Editor: Surface dialog appears.   Enter Name EBWB Shape. 

 
Name and Description Editor: Surface shown 

9. Click OK to proceed. 

10. Select the Display Z Levels tool, to browse elevations (Z Levels) of the selected surface.   

Hint Move the cursor anywhere over the selected surface and the corresponding elevations are 
displayed in the Surface Levels dialog.  If the point indicated is outside of the surface, Bridge 
will display that the point is Outside of the Surface. 

     
                                Surface Levels: EBWB Shapes showing the Z Level and location of the Point 

11. Close the Surface Levels dialog box. 
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 Register “Underpass Shape” Surface  

Under the Surface Data group box: 

                  

1. Select GEOPAK Shapes (Job and Chain) from the “Create By” pulldown list. 

2. Click Browse and select directory C:\DATA\GEO\VDOT\BRIDGE\TRAINING. 

3. Select Job520. 

4. Select SR3A from the Chain pulldown list. 

5. Right mouse-click anywhere within the Bridge tree list.  Select New > Item.   

6. The Name and Description Editor: Surface dialog appears.   Enter Name “Underpass 
Shape”. 

7. Click OK to proceed. 

 Register “Underpass Tin” Surface 

Under the Surface Data group box: 

              

1. Select GEOPAK DTM from the “Create By” pulldown list. 

2. Click Browse and select directory C:\DATA\GEO\VDOT\BRIDGE\TRAINING. 

3. Select Underpass.tin.  Click OK to proceed. 

4. Select the Create Surface tool. 

5. The Name and Description Editor: Surface dialog appears.   Enter Name “Underpass 
Tin”. 

6. Click OK to proceed. 

7. Close the GEOPAK Bridge – Surface Manager Dialog box. 
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BRIDGE LOCATION MANAGER (ALIGNMENTS, PIER LINES, BEAM LAYOUTS AND GRIDS) 
The Bridge Location Manager is responsible for the primary locations for all aspects of your bridge 
models.  Alignments for the bridge deck and beams etc. are registered within the Location Manager. 
 Pier line locations are chosen along the appropriate baseline alignment.  Single span and continuous 
span beam layouts (their centerlines) are established with reference to the alignments and selected Pier 
locations.  Grid patterns are developed and superimposed on beam layouts to generate deck elevations. 

These locations represent the basis for the bridge layout.  For maximum ease of use, they are created 
entirely within the X/Y plane (top view) and require no 3D modeling information or input. 

The Location Manager enables the user to add, delete, and modify various alignments, pier lines, beam 
layouts and grids within the selected bridge previously created in the Project Manager. If no bridge is 
displayed in the dialog title, right mouse click and select the Bridge. 

 
Collapsed Tree Shown 

When the Bridge Location Manager tool is selected the Bridge Location Manager dialog appears. 

The Bridge Location Manager is a Tree like design that contains four main folders -.  the Alignments, 
Pier Lines, Beam Layouts and Grids. 

 

Selecting either the Alignments or Pier Lines folder automatically forces the Bridge Location Manager 
dialog to expand when selected 
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CREATING ALIGNMENTS IN THE BRIDGE LOCATION MANAGER 
Several methods are available in Bridge to create Bridge Alignments:  

•  Offset from GEOPAK Chain, 

•  Offset from Alignment (Bridge Alignment need to be created  first) 

•  Offset from Baseline (the Bridge Master Alignment) 

•  Long/Short Chords between Pier Lines (Pier lines need to be created first) 

•  Arbitrary option is also provided by Picking Points or by indicating MicroStation lines. 

The Bridge Location Manager dialog appears as shown below when all the alignments are created. 

 
                                              Final Bridge Location Managers dialog shown 
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HIGHLIGHTING BRIDGE COMPONENTS 
Bridge components selected in the Bridge Tree list can be highlighted using any of the Hilite options 
available.  You need to Right mouse-click anywhere within the Bridge tree list for the the Pop-up 
menu to appear.  Select the Hilite option from the menu and proceed to select any of the available 
options: Off - no element(s) are hilited.  On - elements are hilited in the MicroStation hilite color. 
 Dynamic - view 7 is opened and the DGN locator elements are windowed and centered in the view. 
 Flash - the selected bridge components flash in the hilited color.  Only one option can be selected at 
the time, however, the Dynamic option responds to the Flash option.  Flash assumes that the hilite is 
on. 

 

 Creating Bridge Alignment “ML1” 

 

TOOL / OPTION DESCRIPTION 

 
Bridge Location Manager 

 

1. Select the Bridge Location Manager tool from the GEOPAK Bridge tools palette. 

2. Select the Alignments folder. The dialog expands. 

Under the Alignment Details group box: 
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3. Select Offset from GEOPAK Chain from the Method pulldown list. 

4. Click Browse and select directory C:\DATA\GEO\VDOT\BRIDGE\TRAINING\. 

5.  Select Job520. 

Under the Horizontal group box: 

6. Select ML1 from the Chain pulldown list. 

Under the Bridge Limits group box: 

7. Select Indicate Start Limit tool.  Indicate a Data Point just inside the beginning of the 
Shapes.  If you wish, modify the input field to Station 220+55.00 (or type 22055.00). 

8. Select Indicate Finish Limit tool.  Indicate a Data Point just inside the end of the Shapes.  If 
you wish, modify the station value to 221+92.00 (or type 22192.00). 

9. Under the Vertical group box, select Not used from the Profile pulldown list. 

10. Right mouse-click anywhere within the Bridge tree list.  Select New > Item. 

11. The Name and Description Editor: Alignment dialog appears.  Enter Name “ML1”.   

12. Click OK to proceed. 

Note The Alignment will appear in the DGN file.  If the alignment is not visible, use the MicroStation 
Fit View tool to update the MicroStation window. 

 Create Alignment “ Eastbound” 

Under the Alignment Details group box: 

 

1. Select Offset from GEOPAK Chain from the Method pulldown list. 

2. Under the Horizontal group box, select ML1 from the Chain pulldown list. 

3. Change the Offset to 14.0. 

4. Under the Vertical group box, select Not used from the Profile pulldown list. 

5. Right mouse-click anywhere within the Bridge tree list.  Select New > Item. 

6. The Name and Description Editor: Alignment dialog appears.  Enter Name “Eastbound”.   

7. Click OK to continue. 
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 Set Alignment as the Bridge Baseline 

This exercise is to set a Bridge alignment as the Bridge Baseline.   

TOOL / OPTION DESCRIPTION 

 
Set alignment as Baseline 

 

1. Under the Alignments folder, select the Eastbound icon.  Notice the icon for this alignment 
looks as shown below. 

 

2. Select the Set alignment as Baseline tool.  The alignment is set as the Baseline of the Bridge 
and the icon changes as shown below. 

 

Note If the Bridge Baseline is modified by changing the alignment, an Alert box will appear alerting 
that changing the Baseline may have significant effect on the Bridge design.  

 Create Additional Bridge Alignments 

Create the Left and Right Edge and the Left and Right Face of Curb.  For Method, select Offset 
from Baseline.  The only change required is the offset value as shown below. 

Note Prior to creating an Alignment, set the Method, Name and Offset as shown below. 

Under Alignment Details group box: 

 

1. Select Offset from Baseline from the Method pulldown list. 

2. Change the Offset input as indicated below. 

3. Right mouse-click anywhere within the Bridge tree list.  Select New > Item. 

4. The Name and Description Editor: Alignment dialog appears.  Enter Alignment Name as 
indicated in table below. 

5. Click OK to proceed. 
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6. Repeat the same process to create the remaining alignments shown in the table below. 

 

METHOD ALIGNMENT NAME OFFSET (+ OR -) 

Offset from Baseline EB LT Edge -5.88 

Offset from Baseline EB LT Face of Curb -5.4 

Offset from Baseline EB RT Edge 7.08 

Offset from Baseline EB RT Face of Curb 6.60 
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CREATING AN ALIGNMENT LIST 
Whenever you have a large list of Alignments and you need to isolate just a few Alignments for 
purposes of easy selection, you can create your own predefined “List” of Alignments. 

Select the “Lists” item at the bottom of the Alignment Manager tree.  Select the “New” option to 
establish a new List.  After entering the name of the List, use the right mouse button menu to Add or 
Clear all alignments in the List. 

Alternatively, you can selectively add existing alignments to the List.  The picture depicted below 
shows the Alignment already selected and the Pop-up menu pulldown list.  In the Pop-up Menu, the 
Lists option is selected.  It shows the available Lists that can be selected; The Face of Curbs list is 
available for selection. 

 

Notice the “Lists” menu contains the name of your new List(s).  Having selected the list name, the 
Alignment is appended to that list.  The entry is updated in the Alignment tree. 

Your Alignment List is made available for selection in all other dialog boxes where an Alignment 
selection is required.  Simply choose the right mouse button at those locations and select the List name 
or the “Master” list.  The available Alignments are updated accordingly. 
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In this exercise an alignment list Face of Curbs will be created.  The List will be used in the 
calculation of Deck Elevations. 

 Create Alignment List “Face of Curbs” 

1. Select the List (Alignments) icon. 

2. Right mouse-click anywhere within the Bridge tree list.  Select New > Item.  

3. The Name and Description Editor: List of Alignment dialog appears. 

4. Enter Name “Face of Curbs”.   

5. Click OK to proceed. 

Note A Folder List (Alignments) and Face of Curbs icon are automatically created. 

6. Select Face of Curbs icon. 

7. Right mouse-click anywhere within the Bridge tree list.  Select Lists > Add All. 

Note Since all created Alignments are added to the list, alignments that do not describe a Face of 
Curb should be deleted. 

8. Expand the Tree for this List by clicking the Plus Sign icon. 

9. Select EB LT Edge from the list.   

10. Right mouse-click anywhere within the Bridge tree list.  Select Delete. 

Note The Delete tool is also available for selection in the right side of the dialog. 

11. Remove EB RT Edge, Eastbound and ML1 alignments from the list. 
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CREATING PIERS LINES AND BEARING LINES IN THE BRIDGE LOCATION MANAGER 
Piers are created in the Bridge Location Manager.  The process begins by selecting the Pier Lines 
folder located in the Bridge trees list. 

Under the Pier Location Data group box, there are several methods available in the Location 
Method pulldown list to locate a Pier Line:  

•  By Station and Skew angle (the Skew Angle can be in degrees, or enable the DMS option to 
define the Skew in degrees, minutes and seconds-space between degrees, minutes and seconds 
is required) 

•  By Station and Bearing 

•  By Station and Azimuth 

•  By Alignment Intersection 

•  By selecting an Existing Pier (distance along Baseline) 

•  By selecting an Existing Pier (offset normal to Pier) 

•  By Picking two Points  

•  By Picking Elements (MicroStation lines). 

At each Pier Line location, Bearing Line Data back and ahead of the pier line is defined by entering 
offset values (normal distances) to the pier line and by selecting the bearing type; Expansion or Fixed 
support. 

 

You can review the pier Skew (in degrees or in degrees minutes and seconds), the Bearing, and   
Azimuth values by using the Bearing/Azimuth/Skew/DMS Display Mode tool.   

Select the Update Pier Line tool to update changes made to the Station, or Skew, or Bearing etc. 
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CREATE PIER LINE “ABUT A” 

 Create Pier Line “Abut A” 

1. Select the Pier Lines folder.  The dialog expands. 

Under the Pier Line Location Data group box: 

 

2. Select Station and Bearing from the Location Method pulldown list. 

3. Enter 220+95.799 (or 22095.799) in the Station key-in field. 

4. Enter N 89 44 5.91 E. in the Bearing key-in field. 

Under the Bearing Line Data group box: 

 

5. Select No Bearing from the Back pulldown list. 

6. Select Expansion from the Ahead pulldown list. 

Note The selection Expansion or Fixed in the Bearing Line Data group box Back or Ahead has not 
effect in any of the calculations performed by Bridge.  This information is only used for 
reporting purposes. 

7. Enter 0.550m for the Ahead offset. 

8. Right mouse-click anywhere within the Bridge tree list.  Select New> Item. 

9.  The Name and Description Editor: Pier Line dialog appears. Name “Abut A”.  

10. Click OK to continue. 

11. Select Bearing/Azimuth/Skew/DMS Display Mode tool, to set the display view to Bearing, 
Azimuth, Skew, or DMS. 

Note Select the Bearing/Azimuth/Skew/DMS Display Mode tool and click several times. Notice in 
the dialog tree next to each pier name, the value changes each time the 
Bearing/Azimuth/Skew/DMS Display Mode tool is selected. 
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CREATE ADDITIONAL PIER LINES 

 Create Additional Pier Lines 

Since the pier lines are parallel, just change the Name, Station and Bearing Line Data as described 
in the table below.  The data should be entered in the dialog prior to creating the Pier. 

 

Pier Line Name Pier 1 Pier 2 Abut B 

Location Method Station and 
Bearing 

Station and 
Bearing 

Station and 
Bearing 

Station 221+ 13.188 221+33.853 221+51.242 

Bearing N 89 44 5.91 E N 89 44 5.91 E N 89 44 5.91 E 

Bearing Back type Expansion Expansion Expansion 

Bearing Back Offset 0.350 0.350 0.550 

Bearing Ahead type Expansion Expansion No Bearing 

Bearing Ahead Offset 0.350 0.350 0.0 

 

1. Select existing pier Abut A icon. 

2. Under the Pier Line Location Data group box, change Station value. 

3. Under the Bearing Line Data group box, change the Offset Back and Ahead. 

4. Right mouse-click anywhere within the Bridge tree list.  Select New > Item.   

5. The Name and Description Editor: Pier Line dialog appears. Enter Pier Name.  

6. Click OK to continue. 

7. Repeat steps above to create the additional pier lines. 
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CREATING PIER LISTS 
User-defined Lists for Pier Lines are often essential in the Bridge modeling process.  Pier Lines are 
created for many purposes.  One use is for the locating physical Piers or Abutments.  They are also 
used for locating the ends of spans, the ends of decks and barriers etc..  A user-defined List of Pier 
Lines is an easy way to isolate just those Piers that beam layouts should span between.  Of course, they 
also make for easy selection amongst a large list of Piers. 

Select the “Lists (Pier Lines)” item at the bottom of the Pier Lines tree.  Select the “New” icon to 
establish a new List.  After entering the name of the List, use the right mouse button menu to Add or 
Clear all pier lines in the List: 

Alternatively, you can selectively add any of your existing Piers to the List by first selecting a Pier and 
then displaying the Lists option by clicking the right mouse button. 

The Pier Line Lists are made available for selection in all other dialog boxes where a Pier selection is 
required. 

 Create the “Interior Span” Pier List 

1. Select the List (Pier Lines) icon. 

2. Right mouse-click anywhere within the Bridge tree list.  Select > New > Item.  

3. The Name and Description Editor: List of Pier Line dialog appears. Enter Name “Interior 
Span”.  

4.  Click OK to continue. 

Note A Folder List (Pier Lines) and Interior Span icon are automatically created. 

5. Select the Interior Span icon. 

6. Right mouse-click anywhere within the Bridge tree list.  Select Lists > Add All. 

Note Since all Pier Lines are added to the list, Pier Lines that do not describe the Interior Span 
should be deleted. 

7. Expand the Tree for this List by clicking the Plus Sign icon 

8. Select Abut A icon from the list. Right mouse-click anywhere within the Bridge tree list.  
Select Delete. 

9. Select Abut B icon from the list. Right Mouse-click anywhere within the Bridge tree list. 
Select Delete. 
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     The Bridge Location Manager dialog appears as shown below when the Pier Lists is created. 

 
     Final Pier List Shown 

CREATE PIER LINES USING THE ALIGNMENT INTERSECTION METHOD 
When there is an Alignment already registered in Bridge, this alignment can be intersected with 
the Baseline. In this exercise, the Baseline intersects the alignment SR3A.  This option places the 
pier line tangential to the intersected alignment. 

 Create Alignment “ SR3A” 

Create the underpass alignment SR3A. 

1. Select the Alignments folder in the Bridge tree list. 

Under the Alignment Details group box:  

2. Select Offset from GEOPAK Chain from the Method pulldown list. 

3. Click Browse and select directory C:\DATA\GEO\VDOT\BRIDGE\TRAINING\. 

4. Select Job520. 

Under the Horizontal group box: 

5. Select SR3A from the Chain pulldown list. 

6. Change the Offset to 0.00. 

7. Under the Vertical group box, select Not used from the Profile pulldown list. 

8. Right mouse-click anywhere within the Bridge tree list.  Select New > Item. 

9. The Name and Description Editor: Alignment dialog appears.  Enter Name “SR3A”.  Click 
OK to continue 
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 Create Pier Line 

1. Select the Pier Lines folder.  The dialog expands 

Under the Pier Line Location Data group box: 

 

2. Select Alignment Intersection from the Location Method pulldown list. 

3. Enable the Parallel option. 

4. Enter 0.0 in the Relative Distance, Interval and Skew key-in fields.  

5. Select SR3A from the Alignment Name pulldown list. 

6. Select the Create new Pier Line tool. 

7. The Name and Description Editor: Pier Line dialog appears.  Enter Name “Test”.  Click 
OK to continue. 

8. Select Bearing/Azimuth/Skew/DMS Display Mode tool, to set the display view to Bearing.  
Compare the Bearing of Abut A and the Bearing of the pier Test.  The Bearings should be the 
same. 

9. Delete the Test pier line. 
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SET BEAM LINES NAMING PATTERN PROPERTIES (DESIGN RULES) 
As groups of components are created, they are automatically given a name in accordance with your 
default Naming Patterns.  You can format your naming pattern from a mix of literal text and any of the 
available naming codes shown in the popup list. 

For example, five spans of beam might be created, each containing 4 beams.  Specifying a Span 
naming pattern as “Span {D-H}”, will generate span names such “Span D”, “Span E” through “Span 
H”.  Note the code {D-H} causing the span sequence to be named with letters starting with the letter 
“D”.  The beams within each span could then be named using “Beam {@}” to generate “Beam A” 
“Beam B” etc. 

 Set or Review Design Pattern Rule Property 

1. Select the Properties Manager tool from in the Bridge tools palette. 

Note The properties shown in the GEOPAK Bridge – Properties Manager dialog are from the 
default properties stored in the default template.  The default values are automatically 
transferred from the default template to the current project when a Bridge Database is created 

2.  Under Bridge Locations icon, select Beam Layouts icon.   

3. Under Beam Layouts icon, select the Design icon.  The dialog changes as shown below. 

 

 

4. Under the Select Naming Category group box, select Regular Beam Lines from the Category 
pulldown list. 

Note Under the Naming Pattern group box, review the naming pattern: Beam {@}.  The word 
“Beam” is the literal part and {@} is the alphabetic pattern selected from the Insert Pattern 
pulldown list. 

5. Close the Properties Manager dialog. 



Creating Beam Layouts and Beam Lines 
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CREATING BEAM LAYOUTS AND BEAM LINES 
The procedure to create Beam Lines begins by creating a Beam Layout name.  The Beam Layout name 
is created by first selecting the Beam Layouts folder located in the Bridge tree list, followed by 
selecting the Create Beam Line tool or by right mouse click anywhere within the Bridge tree list (to 
access the Pop-up menu to select the New > Item option). 

 

The Beam Layout name created is automatically selected by Bridge and the Bridge Location Manager 
dialog expands.  See lower portion of the dialog depicted below. 

 
                                         Bridge Location Manager shown  
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The beam layout options available to define Beam Layouts are located within the Beam Group 
Specifications window in the Beam Geometry pulldown list. The methods available are:   

•  Short Chorded for single spans arrangements. 

•  Continuous Beam Arrangement is available when the Continuous Beam Arrangement option 
is enabled.  When this option is activated,  you can create continuous beams arrangements 
made of: 

o Concentric / Parallel segments 

o Short Chorded segments. 

o And Long Chorded segments.    

The Short Chord method and the Long Chord method are generally used to place beam lines by 
locating the points of intersection between an Alignment and Pier Lines at any specified Offset. 

 

There are three Tabs within the Beam Group Specifications window: 

•  To define the First Beam 

•  To define the Spacing  

•  To define the Last Beam 

Note Enable the Parallel to chord option when a beam line is to be placed parallel to a Chord of 
the selected alignment. 

 



Creating Beam Layouts and Beam Lines 
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There are two general methods to place the first beam: 

•  By the Baseline Alignment.   

 

•  By a Relative Alignment.  The Relative alignment allows for selection of any alignment that 
has been registered in the Alignments folder. 

 

First Beam and Relative Alignment option shown 
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The Last Beam is defined by selecting the Last Beam tab. The options are available only when the 
Active option is enabled.  

 

There are three options to define the Last Beam:  

•  Baseline Alignment 

•  Relative Alignment 

•  Relative To First Beam.  The last beam can be defined parallel to the Chord if the Parallel to 
chord option is enabled. 

 
      Beam Group Specifications window and Last Beam tab options shown 

The Spacing tab is used to define the beam lines from the first beam to the last.  The options available 
are as shown in the partial dialog shown below. 

 
Spacing Tab and Available options shown 

 

 



Create Beam Layout For “Spans A thru C” 
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CREATE BEAM LAYOUT FOR “SPANS A THRU C” 
In this exercise one beam layout will be created for defining the beam lines for Spans A thru C.  The 
beam lines are drawn by selecting the short chords of concentric curves parallel to the Baseline.  These 
beam lines are not necessarily parallel. 

 Create Beam Layout “Spans A thru C” 

1. Select the Beam Layouts folder in the Bridge Location Manager. 

2. Right mouse-click anywhere within the Bridge tree list. Select New > Item.   

3. Name and Description Editor: Beam Layout Group dialog appears. 

4. Enter Name Spans A thru C. 

         

5. Click OK to proceed. 
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CREATE BEAM LINES FOR “SPANS A THRU C” 

 Define the First Beam 

1. Select beam layout Spans A thru C icon in the Bridge tree list.  The dialog expands showing 
the Beam Group Specifications as shown below. 

 
  Location Manager Spans A thru C shown 

Under Beam Group Specifications group box:  

2. Select Master from Pier List pulldown list. 

Note The Pier List pulldown allows the user to select a Pier List.  The Master pier list contains the 
list of all the piers previously created.  The Master option is the default name and it is created 
internally by Bridge. 

3. Select Abut A from the Start Pier pulldown list. 

4. Select Abut B from the End Pier pulldown list. 

5. Click the First Beam tab to define the First Beam. 

6. Select Baseline Alignment from the Method pulldown list. 

Note In this example, beams lines are placed per span using the Short Chord of concentric curves 
to the baseline.  As a result, beams are not necessarily parallel to each other.  If you want to 
place beams lines parallel to the Short Chord of the Baseline, you need to select the Parallel 
to chord option. 

7. Change Offset to -5.0m 



Create Beam Lines For “Spans A thru C” 
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 Define the Last Beam 

Under Beam Group Specifications group box: 

1. Click Last Beam tab to define the Last Beam 

2. Enable the Active option to define the Last Beam. 

Note If all the beams are parallel to the first beam, it is not necessary to define the Last Beam.  

3. Select Baseline Alignment from the Method pulldown list. 

4. Change the Offset to 6.0m 

 
Bottom portion of the Bridge Location Manager shown 

 Define the Beam Spacing 

1. Click the Spacing tab to define the Beam Spacing. 

2. Select Number from the Method pulldown list. 

3. Enter 6 in the Number Key-in field.   

Note The number is defined as the total number of beams in the group. 

4. Select the Modify Beam Line tool to update the information. 

Note Notice that all beams are drawn in the design file. 

 

       
Bottom portion of the Bridge Location Manager shown 
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CREATE GRID LAYOUTS AND GRID LINES FOR CALCULATING ELEVATIONS 
Grid Lines are an imaginary set of lines placed at regular intervals within each span.  They are used to 
calculate elevations at the points of intersection between the beam lines and the Grid Lines and/or Face 
of Curbs or Face of Rails.   Vertical clearances are also calculated, if the surface below is provided. 

Grids lines are tied to the reference alignment, and can be drawn Normal to the alignment, Parallel to 
the Start Pier or Parallel to the Finish Pier.   They can be distributed along an alignment by Spacing, 
Fraction, Number and Stationing calculated between Bearings, between Pier Lines, Along Beam Line 
between Piers and Along Beam line between Bearings.  

If a Reference Alignment is not defined, the Reference Alignment is the Baseline by default.  The 
additional data required are the major Surface, and/or an Alignment list. 

To calculate Surface Elevations, you need to specify the Surface Calculation Mode in the Grid Heights 
Design Properties. 

 

The procedure to create Grid Layout Lines begins by creating the Grid Layout name first.   

The Grid Layout name is created by selecting the Grid Layouts folder in the Bridge Location Manager.  
Grid Layout names are created by selecting the Create Grid tool or by right mouse click anywhere 
within the Bridge tree list to access the Pop-up menu to select the New > Item option. 

 



Create Grid Layouts and Grid Lines for Calculating Elevations 
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The Grid Layout name created is automatically selected by Bridge and the Bridge Location Manager 
dialog expands.  See lower portion of the dialog depicted below. 

 
                                  Lower portion of dialog shows the Grid Specifications window 
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SET GRID LAYOUTS PROPERTIES 
Different properties options are available to Display, Design and Reporting Grid Layouts. 

 Set or Review Grid Layouts Display Properties 

1. Select the Properties Manager tool from the GEOPAK Bridge tools palette. 

Note The properties shown in the GEOPAK Bridge – Properties Manager dialog are from the 
default properties stored in the default template.  The default values are automatically 
transferred from the default template to the current project when a Bridge Database is 
created. 

2. Under Bridge Locations select Grid Layouts icon.  Under Grid Layouts select the Display 
icon.  The dialog changes as shown below. 

Hint Notice that the Project Properties tree can be collapsed and expanded by clicking on the + or 
– icons.  You can use the vertical scroll bar to browse the tree. 

 

The defaults settings under Levels, Line Elements, Text Elements and Plans Production should be 
the same as the ones shown above. 



Set Grid Layouts Properties 
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 Set or Review Grid Layouts Grid Heights Design Properties 

1. Under Bridge Locations select Grid Layouts icon.  Under Grid Layouts select the Grid 
Heights icon and under the Grid Heights icon select the Design icon.  The dialog changes as 
shown below. 

 

2. Check that under the Grid Height Properties, the Surface Elevations Only from the Surface 
Calculation Mode pulldown list is selected. 

3. Click the X top right corner to close the dialog. 

CREATING GRID LAYOUTS AND GRID LINES FOR “SPANS A THRU C” 

 Create Grid Layout for “Spans A thru C” 

1. Select the Grid Layouts folder in the Bridge Location Manager.  

2. Right mouse-click anywhere within the Bridge tree list.  Select New > Item. 

3. Name and Description Editor dialog appears. 

4. Enter name “Grid Layout Spans A thru C”. 

5. Click OK to proceed. 

 
                                                                  Grid Layout Spans A thru C shown 
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CREATING GRID LINES FOR “SPANS A THRU C” 

 Create Grid Lines 

The picture depicted below shows the completed Bridge Location Manager dialog box. 

 

1. Select the Grid Layout Spans A thru C icon.  The dialog expands. 

2. Under Grid Specifications group box, select Spans A thru C from the Beam Layout 
pulldown list. 

Note Notice that under the Grid Specifications the Start Pier, Number of Spans and End Pier are 
automatically selected.  The information was extracted from the data that was used when the 
Beam Layout Spans A thru C was created. 

Under the Grid Layout Data group box:  

3. Select Parallel Back Pier from the Layout Method pulldown list. 

4. Select Along Ref Alignment - between Bearings from the Division of Span pulldown list. 

5. Select Along Grid Line from the Display Mode pulldown list. 

6. Enter Distribution value 0.10 and select Fraction from the Distribution pulldown list. 

Note When you select the Fraction option for the grid distribution, the distribution value can be enter 
as a fraction (decimal value) or as the denominator of the fraction.  For example if you want to 
distribute the grid lines as 1/10 of the span, you can enter either 0.1 or a 10 (the denominator 
of the fraction). 

7. Select No Pier Lines from the Pier Mode pulldown list. 

 



Creating Grid Lines for “Spans A thru C” 
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8. Select Both Bearing Lines from the Bearing Mode pulldown list. 

9. Select Eastbound from the Reference Alignment pulldown. 

At the bottom of the Grid Specifications box: 

10. Select Face of Curbs from the Alignments pulldown list.   

Note The Face of Curbs will be included in the calculations. 

11. Select EBWB Shape from the Elevation Surface pulldown list. 

12. Select the Modify Grid tool to update the changes. 

Note Elevations are calculated and drawn in the DGN file.  If Elevation values are not displayed, Fit 
View the MicroStation window if necessary. 



Creating Grid Lines for “Spans A thru C” 
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 Review Calculated Elevations 

1. Expand the Grid Layout Spans A thru C. 

2. Click on the + icon to expand the Abut A -> Pier 1 icon.  

3. Expand a Grid Line icon.   Each Grid line is shown with Elevations. 

 

Grid Line and Deck Elevations shown 

4. Move the cursor over the circles that appear in the DGN file.  After a short delay, the flyover 
text will show the Elevation at the point. 

5. Right mouse click anywhere within the Bridge tree list, the Pop-up menu appears. Select 
Hilite > On.  Proceed to select any Elevation icon and notice that the Elevation is highlighted 
in the DGN file. 
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CREATE REPORTS 
Reports are based on predefined templates made of Bridge symbols.  These symbols are provided by 
Bridge to describe the reportable data for any component.  For example, when creating deck elevations 
reports, symbols shown in the Grid.rpt template file are used as shown below: 

 

SYMBOLS / GRID.RPT DESCRIPTION 

GridHeightName The name of the grid height ( or grid point were a height was evaluated ) 

XCoord The X coordinates of the grid point. 

YCoord The Y coordinates of the grid point. 

ZCoord The Z coordinate of the grid point recorded at the grid height. 

Station The station to reference alignment (or baseline). 

Offset The offset to reference alignment (or baseline). 
 

PROCEDURE 
Reports are created by using both the Properties Manager and the Reports Manager.   

1. The Reports Manager is where output files are managed. 

2. The Properties Manager tool is where reports are activated and where Report Templates are 
selected. 

REPORTS MANAGER 
The Report Manager is used to create Reports Sets.  Each report set may contain Text, CSV (comma 
separated values) and XML reports.  The report manager  is used to manage the updating, deleting, re-
sequencing and displaying of reports. 

 Create a Report Set 

1. Select the Reports Manager tool from the GEOPAK Bridge tools palette.  The GEOPAK 
Bridge – Reports Manager dialog appears. 

 

2. Select the Create Reports set tool.   

3. The Name and Description Editor: Bridge Component dialog appears. Enter Name 
“TEST”. 

4. Click OK to proceed. 
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5. Select TEST icon. The dialog expands. 

 

6. Under the Report Output Modes group box, enable the Text File option. 

 

7. Select the Select Text File tool.  The default directory appears.  Under Files, enter Report. 

 

8. Click OK to continue. 

 

 

 



Create Reports 
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9. Select the Modify Reports Set tool to update the changes. 

 

10. Expand the TEST tree. Select the Text icon as shown below   

Warning DO NOT CLOSE THE REPORTS MANAGER DIALOG.  We need to proceed with the 
Properties Manager to enable the reports properties. 
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ACTIVATE REPORTS IN THE BRIDGE PROPERTIES 
Reports are activated in the Bridge Properties Manager.  If a Bridge Database template was available 
when the Bridge was created, some of the items under the Report window like the Report template are 
automatically selected If this is the case, select the missing information and select the Modify Report 
tool.  Otherwise, select the Create Report tool. 

 Activate Grid Layouts Report 

1. Select the Properties Manager tool from the GEOPAK Bridge tools palette. 

2. Under the Grid Layouts icon, select the Reports icon. 

 
Global Bridge Properties dialog shown 

3. Under the Reports window, select TEST from the Name pulldown list. 

4. Select Modify Report tool from the right side of the dialog. 

 Activate Grid Heights Report 

1. Under the Grid Heights icon, select the Reports icon. 

2. Under the Reports window, select TEST from the Name pulldown list. 

3. Select Modify Report tool from the right side of the dialog. 

 
Report activated for Grid Heights shown 

4. Close the Bridge Properties dialog 



Update Report 
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UPDATE REPORT 
When reports are activated in the Properties Manager dialog, the Reports Manager can process the 
report. 

 Update Report 

1. Proceed to locate the Reports Manager dialog. 

 

2. Select the Update Report tool.  Wait for processing. 

Note The Report is automatically displayed.  To view the report at any time, select the Display 
Report tool. 



Update Report 
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The Grid Report is partially shown below. 

 

 
Part of Grid Report Shown 

 

The Design file should appear as shown below.   

Warning If Elevation values are not displayed, Fit View the MicroStation window. 

 

 

 

 

Un-Rotated Plan view of Bridge shown 
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 3 
OBJECTIVES 

Develop the Bridge model for Occupacia Creek Bridge. 

The alignment is on a horizontal curve with a radius of 125 meters. Two spans of 13.0 meters with 
substructure units parallel to the flow were necessary to satisfy hydraulics. Type II prestessed beams 
were selected. The bridge is on a sag vertical curve with a constant cross slope of 8%. 

SUBSTRUCTURE UNITS: 

The bent was placed first. It was set at a skew of 40, roughly parallel to the flow. The abutments were 
placed parallel to the bent. This resulted in a skew of 45-57’-32” at Abutment A and 34-2’-28” at 
Abutment B. Setting all of the substructure units parallel would allow all of the beams to be the same 
length, as long as the beams in each span are parallel. 

BEAM LAYOUT: 

Span a -- The initial layout consisted of beams parallel to the short chord. Due to the skew and 
horizontal curvature, the overhangs were too large at one end of the span and at the same time too 
small at the other end. Therefore, the exterior beams could not be placed parallel to the short chord. 
Arcs were drawn concentric to the centerline and offset by 4.6 meters. The exterior beams were placed 
along the chords (running from face of Backwall to C/L bent) of these offset arcs. The overhangs were 
then checked at each end of the span to make sure they were within reasonable limits. The resulting 
beam layout has three interior beams all the same length, equally spaced (2300 mm) and aligned 
parallel to the short chord. The exterior beams are each a different length and are not parallel to each 
other or to the interior beams. 

Span b -- Preferably, the beam spacing in span b would be the same as in span a, and the beams in each 
span would meet at the bent centerline (i.e., the beams in span b would depart the bent at the same 
point the beams in span a arrive). This is not possible with horizontal curvature and skew. The beams 
were set to meet at the same point along the bent centerline. Other than the different beam spacing, the 
beam layout procedure in span b was the same as in span a. The resulting beam layout has three 
interior beams all the same length, equally spaced (2510 mm) and aligned parallel to the short chord. 
The exterior beams are each a different length and are not parallel to each other or to the interior 
beams. 

   OCCUPACIA Creek Bridge 
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GENERAL DATA 
Units: Metric 

Concrete Girders Type II 

Horizontal Alignment: 

SC Sta. 113+02.2473   N 50254.7231 E 99609.7078 

PI Sta. 114+13.3883 LC 168.5179 R 125000 N 50349.4680 E 99668.4530 

CS Sta. 114+70.7652 N 50268.0703 E 99765.1789 

Profile: 

CG Sta. 113+60.000 EL 7.2 VC = 100.00 g1 -2.247% g2 +0.7% 

GPK file available: JOB200 

Shapes available: Shapes.dgn 

Survey Base Line available: RTE637 

Profile Grade Line available: PGRTE637 

Cross Slope: 8% 

Modeling DGN file available: C:\DATA\GEO\VDOT\Bridge\OCCUPACIA 
REEK\Bridge3D.dgn 

 

 

 

 

 

 

 

 

 

 



Plan View and Section on C. L. 
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PLAN VIEW AND SECTION ON C. L. 
Plan and Elevation shown below: 

 



Transverse Section 
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TRANSVERSE SECTION 

 

 



Beam layout 
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BEAM LAYOUT  

 



Beam Layout Part II 
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BEAM LAYOUT PART II 
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STARTING BRIDGE 

 Open Bridge3D.dgn and Attach Shapes.dgn file as Reference  

1. Open Bridge3D.dgn file (C:\DATA\Geo\VDOT\Bridge\ Occupacia Creek). 

2. Select References tool. 

3. Select Attach Reference tool. 

4. Select C:\DATA\Geo\VDOT\Bridge\Occupacia Creek\Shapes.dgn. 

5. Enter for Logical Name Shapes. 

6. Click OK. 

7. Close the References dialog box. 

 Select the Road Project Using the Road Project Manager 

1. Select the Road Project Manager tool. The Project Manager dialog box appears. 

2. Under the Directories list box, select C:\DATA\GEO\VDOT\BRIDGE. 

3. Under the Projects list box, select Occupacia.prj.  The Project Users dialog box appears. 

Note Record in your manual, the Job Number shown in the dialog. 

4. Under the Project Users list box select your name from the list of users. 

Warning If your name is not available, contact your project administrator. 

5. Click OK to continue. 

6. Minimize the Road Project dialog box. 

 Check the Shapes Data and Record the CHAIN name 

1. Select GEOPAK BRIDGE (MicroStation: Applications>GEOPAK BRIDGE>Road 
Tools). 

 

2. Select the Shape Manager tool from the GEOPAK Road tools palette. 

 

3. Select the Shape Analyst tool from the Superelevation Shape Manager Tools palette.  The 
Shape Analyst dialog appears. 

4. Enable the Display Only option. 

5. Click the Dynamic button. Proceed to indicated DP and move the mouse cursor within the 
shapes area. Notice the values displayed in the dialog 

Write in your training manual, the name of CHAIN that appears in the Chain pull down list.  You 
will make references to this chain later in this chapter 



Starting Bridge 
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 Selecting GEOPAK Bridge 

1. Select GEOPAK BRIDGE (MicroStation: Applications>GEOPAK BRIDGE>Modeling). 

 

Note If the database is not available, a new database will be created. 

2. Click OK to proceed. 

3. Select the Configuration Folder VDOT_M.  Select for Units Metric (m). Click OK to 
proceed. 

      
        Bridge Configuration selection dialog 

An Information box appears informing that a Default Bridge database was created. 

4. Click OK to proceed. The Bridge tools appears. 



Creating A New Bridge 
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CREATING A NEW BRIDGE 

 Create a new Bridge 

TOOL DESCRIPTION 

 
Project Manager 

1. Select the Project Manager tool from the GEOPAK Bridge tools palette. 

2. Right mouse-click anywhere within the Bridge tree list. Select New > Item.  

Note Another way to create a Bridge is to select the Create Bridge tool Located in the right side of 
the dialog. 

3. The Name and Description Editor: Bridge dialog appears. 

4. Enter Name “Occupacia Creek”. 

 

5. Click OK to proceed.  The GEOPAK Bridge – Project Manager’s tree list updates 
automatically showing the Occupacia Creek bridge icon. 

 

6. Close the Project Manager Dialog box. 
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CREATE BRIDGE SURFACES 
For more information refer to CREATE A BRIDGE SURFACE in Chapter 1 or in the On-Line Help 
(MicroStation: Applications>GEOPAK>BRIDGE>Help). 

 Register “Road Shape” Surface (Bridge Riding Surface) 

TOOL DESCRIPTION 

 
Surface Manager 

 

Display Z Levels 

 

1. Select the Surface Manager tool from the GEOPAK Bridge tools palette. The Surface 
Manager dialog appears. 

 

                                 Surface Manager Dialog shown    

2. Select the Surfaces folder. The dialog expands. 

 

3. Under Surface Data, select GEOPAK Shapes (Job and Chain) from the Create By pulldown 
list. 

4. Select GEOPAK Job File. Under Surface Data, click on Browse to select the location of the 
Job file. Select  C:\DATA\GEO\VDOT\BRIDGE\OCCUPACIA CREEK\ 

5. Select Job Number.  Select Job200. 

6. Under Surface Data, select Chain RTE637 from the pulldown list. 
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7. Right mouse-click anywhere within the Bridge tree list.  Select New> Item. 

8. The Name and Description Editor: Surface dialog appears. Enter Name “Road Shapes”. 

 

9. Click OK to proceed. 

 
                        Final Surface Manager Dialog shown 

10. Select the Display Z Levels tool, to browse elevations (Z Levels) of the selected surface.   

Hint Move the cursor anywhere over the selected surface and the corresponding elevations are 
displayed in the Surface Levels dialog. If the point indicated is outside of the surface, Bridge 
will display that the point is Outside of the Surface. 

 

 

11. Close the Surface Levels and the Surface Manager Dialog boxes. 
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BRIDGE LOCATION MANAGER (ALIGNMENTS, PIER LINES, BEAM LAYOUTS AND GRIDS) 
The Bridge Location Manager is responsible for the primary locations for all aspects of your bridge 
models. Alignments for the bridge deck and beams etc. are registered within the Location Manager. 
Pier line locations are chosen along the appropriate baseline alignment. Single span and continuous 
span beam layouts (their centerlines) are established with reference to the alignments and selected Pier 
locations. Grid patterns are developed and superimposed on beam layouts to generate deck elevations. 

These locations represent the basis for the bridge layout. For maximum ease of use, they are created 
entirely within the X/Y plane (top view) and require no 3D modeling information or input 

When the Bridge Location Manager tool is selected the Bridge Location Manager dialog appears. 

After a Bridge is created, folders for Alignments, Pier Locations, Beam Layouts and Grid Lines appear 
in the Bridge Location Manager. The Bridge Location Manager displays a tree view of these folders. 
The Bridge Location Manager dialog expands automatically when the alignments or pier lines folder 
are selected. 

 
                            Bridge Location Manager and Folders shown 
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CREATE BRIDGE ALIGNMENTS IN THE BRIDGE LOCATION MANAGER 
Five alignments will be created: the Bridge Baseline, the Left Edge, the Right Edge, the Left Face of 
Rail and the Right Face of Rail.  The first thing you will do is to create the Bridge Baseline alignment, 
second you will set that alignment as the Bridge Baseline and finally you will create the remaining 
alignments based on the Bridge Baseline. 

 Create Bridge Alignment “Occupacia Creek” (Bridge Baseline) 

1. Select the Bridge Location Manager tool from the GEOPAK Bridge tools palette. 

2. Select the Alignments folder. The dialog expands. 

 
                              Expanded dialog box shown 

Under the Alignment Details group box: 

3. Select Offset from GEOPAK Chain from the Method pulldown list. 

4. Click Browse and select directory C:\DATA\GEO\VDOT\BRIDGE\OCCUPACIA 
CREEK\. 

5. Select Job200. 

Under the Horizontal group box: 

6. Select RTE637 from the Chain pulldown list. 

7. Enter Offset 0.00. 
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Under the Bridge Limits group box: 

8. Select the Indicate Start Limit tool. Indicate a Data Point just inside the beginning of the 
Shapes. If you wish type 113+13.00 (or 11313.00) in the Start key-in field. 

9. Select Indicate Finish Limit tool. Indicate a Data Point just inside the end of the Shapes. If 
you wish type 114+53.00 (or 11453.00) in the Finish key-in field. 

Under the Vertical group box: 

10. Select Not used from the Profile pulldown list. 

11. Right mouse-click anywhere within the Bridge tree list. Select New > Item. 

12. The Name and Description Editor: Alignment dialog appears 

13. Enter Alignment Name “Occupacia”.  

14. Click OK to proceed. The Occupacia icon is automatically added to the Alignment tree list. 

 Set Alignment as Baseline 

1. Under the Alignments folder, select the Occupacia icon. 

2. Select the Set alignment as Baseline tool. 

Note If the Bridge Baseline is modified by changing the alignment, an Alert box will appear alerting 
that changing the Baseline may have significant effect on the Bridge design.  

 Create Additional Bridge Alignments 

Create the Left and Right Edge and the Left and Right Face of Rail.  For Method, select Offset 
from Baseline. The only change required is the offset value as shown in table below. 

Note Prior to creating an Alignment, set the Method and Offset 

Under Alignment Details group box: 

1. Select Offset from Baseline from the Method pulldown list. 

Under the Horizontal group box,  

2. Change the Offset input as indicated in table below. 

3. Right mouse-click anywhere within the Bridge tree list. Select New > Item. 

4. The Name and Description Editor: Alignment dialog appears. 

5. Enter Name of Alignment as indicated in table below. Click OK to proceed 

When an Alignment is created, repeat the same steps to create the remaining alignments shown in 
the table below. 

 
Method Offset (+ or -) Alignment Name 

Offset from Baseline -5.200 Left Edge 

Offset from Baseline -4.850 Left Face of Rail 

Offset from Baseline 5.200 Right Edge 

Offset from Baseline 4.850 Right Face of Rail 
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CREATING AN ALIGNMENT LIST 
Whenever you have a large list of Alignments and you need to isolate just a few Alignments for 
purposes of selecting them as a group, you need to create a predefined “List” of Alignments. 

In this exercise an alignment list Face of Rails and Baseline will be created. The List will be 
referenced in the calculation for Deck Elevations. 

 Create Alignment List “Face of Rails and Baseline” 

1. Select the List (Alignments) icon. 

2. Right mouse-click anywhere within the Bridge tree list.  Select New > Item. 

3. The Name and Description Editor: List of Alignment dialog appears. 

4. Enter Name “Face of Rails and Baseline”.  Click OK to proceed. 

Note A Folder List (Alignments) and the list Face of Rails and Baseline icon are automatically 
created. 

5. Select the Face of Rails and Baseline icon. 

6. Right mouse-click anywhere within the Bridge tree list.  Select Lists > Add All. 

Note Since all created Alignments are added to the list, alignments that do not describe a Face of 
Rail or the Baseline should be deleted. 

7. Expand the Tree for Face of Railss and Baseline. Click the Plus Sign icon. 

8. Select Left Edge from the list. 

9. Right mouse-click anywhere within the Bridge tree list.  Select Delete. 

Note The Delete tool is also available for selection in the right side of the dialog. 

10. Remove Right Edge alignments from the list using the same procedure. 

 
            Alignment List Face of Rails and Baseline shown 

 

 



Creating Pier Lines and Bearings Lines in the Bridge Location Manager 

 

 

VDOT Bentley Bridge Training Manual 2004 Edition 
6/8/2006 3-16                                                         

CREATING PIER LINES AND BEARINGS LINES IN THE BRIDGE LOCATION MANAGER 
There are several methods available to locate a Pier Line:  

•  By Station and Skew angle.  Two options are available: 

o  Skew Angle in degrees 

o Skew Angle in DMS format (Degrees Minutes Seconds) 

Note Extra spaces between degrees, minutes and seconds are required. 

•  By Station and Bearing 

•  By Station and Azimuth 

•  By Alignment Intersection 

•  By selecting an Existing Pier (distance along Baseline) 

•  By selecting an Existing Pier (offset normal to Pier) 

•  By Picking two Points 

•  By Picking Elements (MicroStation lines) 

At each Pier Line location, Bearing Line Data back and ahead of the pier line is defined by entering 
offset values (normal distances) to the pier line and by selecting the bearing type; Expansion or Fixed 
support. 

The first pier line that needs to be defined is the Interior pier, so that it can be used as reference to 
create the locations and directions of Abutment A and Abutment B. In this exercise, the Topo.dgn file 
which shows the local conditions (the Creek location and flow direction) is used as reference for the 
preliminary design of the location and skew angle of the interior pier. 

The preliminary location and direction of the Interior Pier is first defined by drawing a MicroStation 
line running along to the middle of the Creek. The MicroStation line is the element that Bridge will use 
to create the preliminary pier line.   

When the preliminary pier line has been located, you can review the Station, Skew, Bearing, Azimuth 
data, using the Bearing/Azimuth/Skew/DMS Display Mode tool. You can also change the Station, or 
Skew, or Bearing values as required and select the Update Pier Line tool to save the changes to finalize 
the location of the Pier Line. 
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CREATE “C.L. BENT” 

 Create the Preliminary Interior pier line location “C.L. Bent” 

1. Select References tool. 

2. Select Attach Reference tool. 

3. Select C:\DATA\Geo\VDOT\Bridge\Occupacia Creek\ s15256Revised.dgn 

4. Enter for Logical Name “Topo” and click OK to proceed. 

5. Draw a Line intersecting the baseline and running along the middle of the Creek. 

Hint There is a line already provided in the Topo file. If you choose another location, proceed now 
to draw that line. 

 

6. Select the Pier Lines folder.  The dialog expands. 

Under the Pier Line Location Data group box: 

7. Select Station and Skew Angle from the Location Method pulldown list. 

8. Enable the DMS option. 

9. Click Pick Elements. 

10. Select the MicroStation line.  Accept the selection. 

11. Select the Create new Pier Line tool. The Name and Description Editor: Pier Line dialog 
appears. 

12. Enter Pier Name “C.L. Bent”. Click OK to continue. 

13. Review data calculated by Bridge. Station 113+62.58 and Skew 40° 40’ 38.33” as shown 
below. You will use this data to determine the final Station and Skew angle. 

 



Create “C.L. Bent” 
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14. Assume you decide that, for this example, the Skew Angle should be rounded to 40.00 
degrees and the Station to 113+62.00. Make the changes in the Station and Skew key-in 
fields. 

15. Select the Modify Pier Line tool to update the changes. 

Note If you wish, you can delete the line you drew in step 4 using MicroStation delete command. 

 Define Bearing Line Data 

Under the Bearing Line Data group box: 

1. Select Expansion from the Back pulldown list. 

2. Enter Offset 0.350 m for Back. 

3. Select Expansion from the Ahead pulldown list. 

4. Enter Offset 0.350 m for Ahead. 

5. Select the Modify Pier Line tool to save the changes. Partial Bridge Location Manager dialog 
shown below. 

 

 
Lower portion of the Bridge Location Manager shown 

 

Note Select the Bearing/Azimuth/Skew/DMS Display Mode tool and click several times as 
required until the Bearing is displayed. Notice the Bearing of the Pier Line is S 23ˆ 51’ 37.34” 
W.   The Abutment A and B are now to be set parallel to the C.L. Bent. 
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CREATE “ABUTMENT A” 
There are three options to create the Abutment “A” pier line; 

 By using the Location Method Existing Pier (distance along Baseline) 

 By using the Location Method Existing Pier (offset  normal to Pier) 

 By using the Bearing direction of the C.L. Bent as described above 

In this exercise the Existing Pier (distance along Baseline) option is used. 

 It was decided the “Abutment A” is to be located 13.00m along the baseline from the C.L. Bent. 

 Create  “Abutment A” Pier Line 

Under Pier Line Location Data group box: 

 

1. Select Existing Pier (distance along baseline) from the Location Method pulldown list. 

2. In the Interval key-in field enter 13.0m. 

3. Select the Subtract Station Interval tool once. 

Note Notice the Relative Distance field changes to negative 13.00m. 

4. Enable the Parallel option (parallel to existing pier). 

Note Enabling the Parallel option, forces the Skew value to zero (skew angle measured relative to 
the selected Existing Pier).  

5. Select C.L. Bent icon from the Pier Name pulldown list. 

 Define Bearing Line Data 

Under the Bearing Line Data group box: 

 

1. Select No Bearing from the Back pulldown list. 

Note The Offset value defaults to zero. 

2. Select Expansion from the Ahead pulldown list. 

3. Enter Offset 0.550 m for Ahead. 

4. Select the Create new Pier Line tool. The Name and Description Editor: Pier Line dialog 
appears. 



Create “Abutment B” 
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5. Enter Pier Name Abutment A. Click OK to continue. 

6. Select the Bearing/Azimuth/Skew/DMS Display Mode tool. 

Hint Select the tool several times as required, until the Bearing is displayed. Notice the Bearing 
direction of the pier lines.  They are the same and equal to S 23ˆ 51’ 37.34” W.   To view the 
Skew Angle, select the Bearing/Azimuth/Skew/DMS Display Mode tool,  until the Skew 
angle is displayed in Degree, Minutes and Seconds 

CREATE “ABUTMENT B” 
In this exercise the Station and Bearing option is used. 

It was decided the “Abutment B” is to be located 13.00m along the baseline from the C.L. Bent. 

 Create Pier Line for “Abutment B” 

1. Select C. L. Bent icon. 

Under Pier Lines Location Data group box: 

 

2. Select Station and Bearing from the Location Method pulldown list. 

3. Enter 13.0m in the Interval key-in field. 

4. Enter Bearing direction S 23 51 37.34 W. 

5. Select once the Add Interval Station tool. 

 Define Bearing Line Data 

Under the Bearing Line Data group box: 

 

1. Select Expansion from the Back pulldown list. 

2. Enter Offset 0.550m for the Back. 

3. Select No Bearing from the Ahead pulldown list. 

4. Select the Create new Pier Line tool. 

5. The Name and Description Editor: Pier Line dialog appears. 

6. Enter Pier Name “Abutment B”. Click OK to proceed. 
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BREAK BACKS 
When Pier skew angles exceed a minimum required angle, the deck corners are modified by adding a 
break. This is called Break Back. 

 

The Break Backs are defined in the Bridge Location Manager under the Pier Folders at each pier line. 
You need to select the Break-Back Specifications tool under the Pier line Location Data. 

 

 



Break Backs 
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The Break Back Data dialog appears as shown below. There are two tabs to define the break backs: 
One tab to define the left side and another one to define the right side. 

 

The Mode pulldown list will allow you to Automatic place, turn On and to turn Off a break back. The 
Alignment pulldown list is to select the reference alignment and an offset key-in field to start the 
break. The offset is measured positive when the distance is to the right of the reference alignment. 

 Place Break Backs in the Left and Right in Abutment A 

1. Under the Pier lines folder, Select the Abutment A icon. 

2. Under Pier Line Location Data, select Break-Back Specifications tool. The break Back Data 
dialog appears.  

 

3. Select Left Face of Rail icon from the Intersect With pulldown list. 

 

4. In the offset field type .215m (positive to indicate towards the right side of the selected 
alignment). 
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5. Select the Modify Pier Line tool to update the changes. Notice that the pier line is modified 
to show the break back. 

 

Repeat the same steps to add a break back on the right side of the deck. 

6. Select the Break Back Right tab. 

7. Select Right Face of Rail from the Intersect With pulldown list. 

8. Enter Offset value -.215m. 

9. Select the Modify Pier Line tool. 

 Place Break Backs in the Left and Right side in Abutment B 

1. Select Abutment B icon. 

2. Under Pier Line Location Data, select Break-Back Specifications tool. 

3. Select the Break Back Left tab. 

4. Select the Left Face of Rail from the Intersect With pulldown list. 

5. Enter Offset value .215m. in the offset key-in field. 

6. Select the Modify Pier tool. 

Repeat the same steps to add a break back on the right side of the deck. 

7. Select the Break Back Right tab. 

8. Select Right Face of Rail from the Intersect With pulldown list. 

9. Enter Offset value -.215m. 

10. Select the Modify Pier tool. 
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CREATE BEAM LAYOUTS AND BEAM LINES FOR “EXT. BEAMS SPAN A AND B” 
Two beam layout Groups need to be created. The Exterior girders are defined by the short chord of 
baseline at offsets of 4.6 m in both spans A and B. The Interior girders are defined by beam lines 
parallel to the short chords of the baseline, but the beam spacing for Span A is different than for the 
Span B. 

CREATE EXTERIOR BEAMS LAYOUT FOR “EXT. BEAMS SPAN A AND B” 

 Create Exterior  Beam Layout for “Ext. Beams Span A and B” 

1. Select Beam Layouts folder in the Bridge items list. 

2. Right mouse-click anywhere within the Bridge tree list. Select New > Item.   

3. Name and Description Editor: Beam Layout Group dialog appears. 

4. Enter Name “Ext. Beams Span A and B”. Click OK to proceed. 

CREATE EXTERIOR BEAM LINES FOR “EXT. BEAMS SPAN A AND B” 

 Define the First Beam 

1. Select beam layout Ext. Beams Span A and B. The dialog expands. 

Under the Beam Group Specifications group box: 

 

2. Select Short Chorded from the Beam Geometry pulldown list. 

3. Select Abutment A icon from the Start Pier pulldown list. 

4. Select Abutment B icon from End Pier pulldown list. 

5. Click First Beam tab to define the First Beam. 

6. Select Baseline Alignment from the Method pulldown list. 

Note In this example, beams lines are placed per span using the Short Chord of concentric curves 
to the baseline.  As a result, beams are not necessarily parallel to each other.  If you want to 
place beams lines parallel to the Short Chord of the Baseline, you need to select the Parallel 
to chord option.  

7. Change Offset to -4.6m (negative is to the left of the Baseline). 
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 Define the Last Beam 

Under the Beam Group Specifications group box: 

 

1. Click Last Beam tab to define the Last Beam 

2. Enable the Active option to define the Last Beam. 

3. Select Baseline Alignment from the Method pulldown list. 

4. Change the Offset to 4.6m (positive is to the right). 

 Define the Beam Spacing 

1. Click the Spacing tab to define the Beam Spacing. 

 

2. Select Number from the Method pulldown list. 

3. Enter 2 in the Number key-in field. 

Note The number is defined as the total number of beams in the group. 

4. Select the Modify Beam Line tool to update the information. 

Note Notice the beams are added to the design file. 



Create Interior Beams Layout for “Int. Beams Span A and B” 
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CREATE INTERIOR BEAMS LAYOUT FOR “INT. BEAMS SPAN A AND B” 
In this exercise you will use the Ext. Beams Layout Group already created as a template to create a 
new beam group. 

CREATE INTERIOR BEAM LINES FOR “INT. BEAMS SPAN A AND B” 

 Define the First Beam 

1. Select Beam Layout icon Ext. Beams Span A and B icon. 

Under the Beam Group Specifications group box: 

 

Note The Start Pier Abutment A and the End Pier Abutment B icons are already selected. 

2. Click First Beam tab to define the First Beam. 

3. Select Baseline Alignment from the Method pulldown list. 

4. Change Offset to -2.3 m 

5. Under the First Beam tab, enable the Parallel to chord option. 

Note In this example, the interior beams will be placed parallel to the Short Chord of the Baseline. 

 Define the Last Beam 

1. Click Last Beam tab to define the Last Beam. 

Note It is not necessary to define the Last Beam when all beams are parallel to each other.  Under 
the Spacing tab, there is a method available for Exact Spacing and Number. The Spacing can 
be a negative value, indicating that beams are spaced towards the left of the first beam.   

2. Enable the Active option to define the Last Beam. 

3. Select Relative to First Beam from the Method pulldown list. 

Note Notice that under the Last Beam tab, the Parallel to Chord option appears ghosted. It is 
assumed that the beams lines are parallel to each other. 

 
         Bottom Portion of the dialog shown 

4. Change the Offset to 4.6m. 
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 Define the Beam Spacing 

1. Click the Spacing tab to define the Beam Spacing. 

 

2. Select Number from the Method pulldown list. 

3. Enter 3 in the Number key-in field. 

 Create Interior  Beam Layout for “Int. Beams Spans A and B” 

1. Right mouse-click anywhere within the Bridge tree list. Select New > Select Item.   

2. Name and Description Editor: Beam Layout Group dialog appears. 

3. Enter Name Int. Beams Span A and B.  Click OK to proceed 

Note Notice that all beams are drawn in the design file and are parallel to each other. Also, notice 
that the Exterior Beams names are Beam A and Beam B and for the Interior Beams the 
names are Beam A, Beam B and Beam C. You need to rename the beams so that the 
Exterior beams become Beam A and Beam E and the Interior beams become Beam B, Beam 
C and Beam D. 

MODIFY A BEAM LAYOUT WITHIN A SPAN 
This exercise is to modify the second span beam spacing. Use the Use Local Beam layout 
specifications in this span option. 

 Modify the First Beam in Span B 

1. Under the Beam Layouts folder, select Int. Beams Span A and B icon. 

2. Click the Plus Sign icon to expand the tree. 

3. Select the CL Bent -> Abutment B icon. 

 

 

                       Upper part of the dialog shown 
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Under the Beam Span Specifications group box: 

4. Enable the Use Local Beam layout specifications in this span option. The dialog options 
now appear active. 

 

5. Click First Beam tab to define the First Beam. 

6. Change Offset to -2.51m. 

 Modify the Last Beam in Span B 

Under the Beam Span Specifications group box: 

 

1. Click Last Beam tab to define the Last Beam. 

2. Change the Offset to 5.02m. 

3. Select the Modify Beam Line tool to update the changes. 
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RENAME THE EXTERIOR BEAM LINES 

 Rename Exterior “Beam B” to “Beam E” 

1. Select the Ext. Beams Span A and B icon and expand the tree. 

2. Under the Properties icon, select the Design icon. 

 

3. Double Click on the Design icon. The GEOPAK Bridge properties dialog appears. 

4. Under the Select Naming Category group box, select Regular Beam Lines from the Category 
pulldown list. 

 

5. Under the Naming Pattern group box, change Beam {@} to Beam {A,E}. 

6. Close the GEOPAK Bridge Properties dialog.  The Bridge Naming tools appears. 

7. Select the Update Naming Sequence tool. The Bridge Naming Update dialog appears. 
 

 



Rename The Interior Beam Lines 
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8. Select Raname all groups tool from the right side of the dialog. 

 

Note Notice that the Exterior Beams were renamed accordingly. 

Close the Bridge Naming Update dialog box. 

RENAME THE INTERIOR BEAM LINES 

 Rename Interior Beams A thru C to Beams B thru D 

1. Select the Int. Beams Span A and B icon and expand the tree. 

2. Under the Properties icon, select the Design icon. 
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3. Double Click on the Design icon.  The GEOPAK Bridge - Properties dialog appears. 

4. Under the Select Naming Category group box, select Regular Beam Lines from the Category 
pulldown list. 

  

5. Under the Naming Pattern group box, change Beam {@} to Beam {B-D}. 

6. Close the GEOPAK Bridge Properties dialog.  The Bridge Naming tools appears. 

7. Select the Update Naming Sequence tool. The Bridge Naming Update dialog appears. 

8. Select Raname all groups tool from the right side of the dialog. 

  

Note Notice that the Interior Beams were renamed accordingly. 

Close the Bridge Naming Update dialog box. 
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CREATE GRID LAYOUTS AND GRID LINES FOR CALCULATING ELEVATIONS 
For more information refer to Create Grid Lines for Calculating Elevations in Chapter 1 or in the 
On-Line Help (Applications>GEOPAK>BRIDGE>Help). 

DECK ELEVATIONS ALONG BEAM LINES 
In the exercise Beam Lines are divided in four equal spaces between Bearing Lines as shown below. 

 

 

 

Table of Elevations for Span A and B are shown below.   

 

 

Table from existing plans shown 
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SET OR REVIEW GRID LAYOUTS-GRID HEIGHTS PROPERTIES 
Different properties options are available to Display, Design and Reporting Grid Layouts. 

 Set or Review Grid Layouts Display Properties 

1. Select the Properties Manager tool from the GEOPAK Bridge tools palette. 

Note The properties shown in the GEOPAK Bridge – Properties Manager dialog are from the 
default properties stored in the default template. The default values are automatically 
transferred from the default template to the current project when a Bridge Database is 
created. 

2. Under Bridge Locations select Grid Layouts icon. Under Grid Layouts select the Display 
icon. The dialog changes as shown below. 

Hint Notice that the Project Properties tree can be collapsed and expanded by clicking on the + or 
– icons. You can use the vertical scroll bar to browse the tree. 

 

The defaults settings under Levels, Line Elements, Text Elements and Plans Production should be 
the same as the ones shown above. 
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 Set or Review Grid Layouts Grid Heights Design Properties 

1. Under Bridge Locations select Grid Layouts icon.  Under Grid Layouts select the Grid 
Heights icon and under the Grid Heights icon select the Design icon. The dialog changes as 
shown below. 

 

2. Check that under the Grid Height Properties, the Surface Elevations Only from the Surface 
Calculation Mode pulldown list is selected. 

3. Click the X top right corner to close the dialog. 
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CREATE GRID LAYOUTS AND GRID LINES FOR “BEAMS SPAN A AND B” 
In this example you have created two groups of beams: One for the Interior beams and another for the 
Exterior beams. When a Grid Layout is created, you need to select a Beam Layout from the Beam 
Layout pulldown list under the Grid Specifications group box. 

 

Since the Beam Layouts are not grouped (using the Lists [Beam Layouts]), you will need to create 
separate Grid Layouts per each Beam Layout created. To avoid this situation, you need to create a 
Beam Layout List first. 

 Create List [Beam Layout] “All Beams Span A and B” 

1. Under the Beam Layouts icon select the List [Beam Layouts] icon. 

 

2. Select the Create List tool from the right side of the dialog. 

3. The Name and Description Editor: Grid Group dialog appears. 

4. Enter Name “All Beams Span A and B” 

 



Create Grid Layouts and Grid Lines for “Beams Span A and B” 
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5. Click OK to continue. The Bridge Location Manager changes as shown below: 

 

6. Under the Beam Layouts icon, select the Ext. Beams Span A and B icon. 

7. Right mouse click anywhere within the Bridge Tree list. Select Lists > All Beams Spans A 
and B. 

 

8. Under the Beam Layouts icon, select the Int. Beams Span A and B icon. 

9. Right mouse click anywhere within the Bridge Tree list. Select Lists > All Beams Spans A 
and B. The dialog changes as shown below: 
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CREATE GRID LAYOUT AND GRID LINES FOR “ALL BEAMS SPAN A AND B” 

 Create Grid Layout “All Beams Spans A and B” 

1. Select the Grid Layouts folder in the Bridge Location Manager. 

2. A Right mouse-click anywhere within the Bridge tree list. Select New > Item. 

3. The Name and Description Editor: Grid Group dialog appears. 

4. Enter name “All Beams Spans A and B”.  Click OK to proceed. 

 Create Grid Lines for “All Beams Spans A and B” 

1. Under the Grid Layouts folder, select All Beams Spans A and B icon. The dialog expands. 

Under the Grid Specifications group box: 

 

2.  Select All Beams Spans A and B icon from the Beam Layout pulldown list. 

3. Select Abutment A from the Start Pier pulldown list. 

4. Select Abutment B icon from the End Pier pulldown list. 

Under the Grid Layout Data group box: 

 

5. Select Parallel Back Pier from the Layout Method pulldown list 

6. Select Along Component between Bearings from the Division of Span pulldown list. 

Note Deck Levels are calculated along each individual component.  

7. Enter Distribution value 4 and select Fraction from the Distribution pulldown list. 

8. Select No Pier Lines from the Pier Mode pulldown list. 

9. Select Both Bearing Lines from the Bearing Mode pulldown list. 

10. Select Occupacia icon from the Reference Alignment pulldown list. 

At  the bottom of the Grid Specifications box: 

11. Select None Selected from the Alignments pulldown list.   

12. Select Road Shapes icon from the Elevation Surface pulldown list. 

13. Select None Selected from the Clearance Surface pulldown list. 

14. Select the Modify Grid tool to update the changes. 

Note Elevations are now calculated and drawn in the DGN file. If Elevation values are not 
displayed, execute a Fit View on the MicroStation window. 

 



Create Grid Layouts and Grid Lines for “face of rails and baseline” 
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CREATE GRID LAYOUTS AND GRID LINES FOR “FACE OF RAILS AND BASELINE” 
Face of Rails and Baseline are divided in four equal spaces between Pier Lines to calculate the Deck 
Elevations. 

 

 

     
Deck Elevations required at locations shown 
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 Create Grid Lines for “Face of Rails and Baseline 

Continue working in the Bridge Location Manager dialog box. 

 

1. Under the Grid Layouts folder , select All Beams Span A and B icon. 

2. Under the Grid Specifications group box, select None Selected from the Beam Layout 
pulldown list. 

Under the Grid Layout Data group box: 

3. Select Along Component between Piers from the Division of Span pulldown list. 

4. Select Both Piers Lines from the Pier Mode pulldown list. 

5. Select No Bearing Lines from the Bearing Mode pulldown list. 

6. Under the Grid Specifications group box, select Face of Rails and Baseline icon from the 
Alignments pulldown list. 

Note The Face of Rails and Baseline will be included in the calculations 

7. Right mouse-click anywhere within the Bridge tree list. Select New > Item.  The Name and 
Description Editor: Grid Group dialog appears. 

8. Enter name Face of Rails and Baseline. Click OK to proceed. 

Note Elevations are calculated and displayed in the DGN file. 
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CREATE REPORTS 

PROCEDURE 
Reports are created by using both the Properties Manager and the Reports Manager. 

1. The Reports Manager is where output files are managed. 

2. The Properties Manager tool is where reports are activated and where Report Templates are 
selected. 

REPORTS MANAGER 
The Report Manager is used to manage the output of Text, CSV and XML files. It is also used to 
manage the updating, deleting, re-sequencing and displaying of reports. 

 Create a Report Set 

1. Select the Reports Manager tool from the GEOPAK Bridge tools palette.  The GEOPAK 
Bridge – Reports Manager dialog appears. 

 

2. Select the Create Reports set tool.   

3. The Name and Description Editor: Bridge Component dialog appears. Enter Name 
“Occupacia”. 

4. Click OK to proceed. 
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5. Select the Occupacia icon. The dialog expands. 

 

6. Under the Report Output Modes group box, enable the Text File option. 

 

7. Select the Select Text File tool. 

 

8. The default directory appears.  Under Files, enter Elevations. 

9. Click OK to continue. 

 



Create Reports 
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10. Select the Modify Report Set tool to update the changes. 

         

11. Expand the Occupacia tree. Select the Text icon as shown below: 

Warning DO NOT CLOSE THE REPORTS MANAGER DIALOG.  We need to proceed with the 
Properties Manager to enable the reports properties. 
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ACTIVATE REPORTS IN THE BRIDGE PROPERTIES 

 Activate Grid Layouts Report 

1. Select the Properties Manager tool from the GEOPAK Bridge tools palette. 

2. Under the Grid Layouts icon, select the Reports icon. 

.  
Global Bridge Properties dialog shown 

3. Under the Reports window, select Occupacia from the Name pulldown list. 

4. Select Modify Report tool from the right side of the dialog. 

 Activate Grid Heights Report 

1. Under the Grid Heights icon, select the Reports icon 

2. Under the Reports window, select Occupacia from the Name pulldown list. 

3. Select Modify Report tool from the right side of the dialog. 

 
Report activated for Grid Heights shown 

6. Close the Bridge Properties dialog. 

 



Update Report 

 

 

VDOT Bentley Bridge Training Manual 2004 Edition 
6/8/2006 3-44                                                         

UPDATE REPORT 
When reports are activated in the Bridge Properties dialog, the Report Manager processes the report. 

 Update Report 

1. Proceed to locate the Reports Manager dialog. 

 

2. Select the Update Report tool. Wait for processing. 

Note The report is automatically displayed. To view the report at any time, select the Display Report 
tool. 

The Grid Report is partially shown below. 

 
Part of Grid Report Shown 
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The Design file should appear as shown below. 

Warning If Elevation values are not displayed, execute a Fit View of the MicroStation window. 

 
Un-Rotated Plan view of Bridge shown 
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 4 
OBJECTIVES 

Develop the Bridge model for Ellerslie Ave. Bridge. 

The alignment is on a horizontal curve with a radius of 9654.24 feet. The bridge is on a hump vertical 
curve and is crowned at ¼” per foot. The substructure units are all parallel. Each has a different skew 
because of the curvature. The span layout is 47’-76’-47’ continuous steel rolled beams. A constant 8’-
0” beam spacing is used, and the beams are laid out parallel to the long chord. Beams E and F (the 
center beams) are each 4’-0” offset from the long chord. Because the horizontal curve is so flat (the 
middle ordinate is approximately 4½”), the outside edges of the deck were made straight (instead of 
following the curvature).  However, the faces of the sidewalk curb follow the curvature. Therefore, the 
sidewalk width varies. 

LAYOUT PROCEDURE 
Orientation (skew angle) and location (station) of Pier 1. 

1. a. Orientation of Pier 1:  In order to minimize the bridge length, substructure units are usually 
aligned approximately parallel to the railroad tracks or roadway underneath. In this example, both 
sets of tracks are in a horizontal curve. The designer constructed a straight line that would 
approximate the C/L of the tracks. The C/L of Pier 1 is set parallel to this line. At this time the 
skew angle is not known. Since the bridge baseline is horizontally curved, the skew of Pier 1 will 
not be known until its location is set. 

b. Location of Pier 1:  The location is chosen to satisfy the requirements (horizontal clearance, 
clearance to avoid shoring, etc.) given in the Office Practice. Locations of utilities or existing 
ditches may also influence the pier location. In this example, the designer chose station 50+72.00. 

c. Skew Angle of Pier 1:  The Pier 1 C/L is placed at station 50+72.00 at the alignment determined 
in step 1(a).  The skew angle at Pier 1 (angle between C/L pier and a radial line) is measured. In 
this example, the skew angle is 12-42’-41”. 

2. Orientation of Other Substructure Units:  In order to keep all the beams the same length, all of the 
substructure units are kept parallel to each other (this is only true for straight beams). Since the 
orientation of Pier 1 is already known, all other substructure units are placed parallel to Pier 1. 

 
3. Beam Layout:  Since the horizontal curve is very flat, the first choice is to use straight beams 

instead of curved. Since the alignment is curved and the beams are straight, a chord is used to 
reference the beams. The long chord is used to lay out the beams. The long chord is a line running 
from the intersection of the baseline and End of Slab at Abut. A and the intersection of the 
baseline and End of Slab at Abut. B. All beams are parallel to the long chord. 

Note Because the abutments are integral, End of Slab was used. For conventional abutments, use 
Face of Backwall. 

 

   Ellerslie Ave. Bridge 
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4. Check Angle Between C/L Pier 1 and Long Chord (and adjust if necessary):  The angle between 
C/L Pier 1 and the long chord is determined.  In this example, it is 12-29’-10”. This angle is used 
on the Curved Bridge Layout, Framing Plan, and in the plan view on the substructure sheets. This 
is the angle the Contractor uses to lay out the substructure units. You should adjust the orientation 
of Pier 1 so that this angle is an even 11. This slightly reduces the minimum horizontal 
clearances, but the clearances still meet all requirements. The skew angle at Pier 1 now changes to 
11-13’-32”.  All other substructure units must be re-aligned so they are parallel to Pier 1. The 
skew angle can now be determined for all other substructure units. 

Note You could just as easily choose 12 or 10, as long as all clearance requirements are met. 
 
5. Face of Sidewalk Curbs:  In order to match the approach face of curbs, the face of sidewalk curbs 

on the bridge is offset 30’-0” radial from the baseline. The baseline and face of sidewalk curb lines 
follow concentric curves. 

 
6. Layout Outside Edge of Deck:  Because the horizontal curvature is slight, the outside edges of the 

deck can be made straight. This simplifies design and construction. As with the beams, the edges 
of deck are parallel to the long chord. Because the horizontal curve is to the right, the middle 
ordinate (approximately 4½”) is to the left of the long chord. Therefore, the minimum offset 
between the long chord and the left edge of deck is: 

0.375’ middle ordinate 

30.0’ baseline to face of sidewalk curb 

7.5’ min. sidewalk width 

1.33’ width of rail 

39’-2 ½” total               

The designer chose to use 39’-3”. 

 To keep the bridge symmetrical, the same offset is used for the right edge of deck. You must 
verify that the minimum sidewalk width on the right side does not fall below 7’-6”. 
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REFERENCE MATERIAL 
Units: English 

Bridge Modeling DGN file available: C:\DATA\GEO\VDOT\Bridge\ELLERSLIE 
AVE\EleerslieBridge3D.dgn 

Steel Girders 

GPK file available: JOB300 

Horizontal Alignment: ELLERSLIE 

 

Profile Grade Line available: Ellerslie 

Shapes available: Shapes.dgn 

Cross Slope: 2.08 % CROWNED 

 



Plan View and Section on C.L. 
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PLAN VIEW AND SECTION ON C.L. 

 



Transverse Section 

 

VDOT Bentley Bridge Training Manual 2004 Edition 
6/8/2006 4-5 

TRANSVERSE SECTION 

 



Beam Layout (Beams parallel to Long Chord) 
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BEAM LAYOUT (BEAMS PARALLEL TO LONG CHORD) 
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STARTING BRIDGE 

 Open EllerslieBridge3D.dgn and Attach Shapes.dgn file as Reference 

1. Open > C:\DATA\Geo\VDOT\Bridge\Ellerslie Ave\ EllerslieBridge3D.dgn 

2. Select References tool. 

3. Select Attach Reference tool. 

4. Select C:\DATA\Geo\VDOT\Bridge\Ellerslie Ave\Shapes.dgn 

5. Enter for Logical Name Shapes. 

6. Click OK. 

7. Close the References dialog box. 

 Select the Road Project Using the Road Project Manager 

1. Select the Road Project Manager tool. The Project Manager dialog box appears. 

2. Under the Directories list box, select C:\DATA\GEO\VDOT\BRIDGE. 

3. Under the Projects list box, select Ellerslie.prj.  The Project Users dialog box appears. 

Note Record in your manual, the Job Number shown in the dialog. 

4. Under the Project Users list box select your name from the list of users. 

Warning If your name is not available, contact your project administrator. 

5. Click OK to continue. 

6. Minimize the Road Project dialog box. 

 Check the Shapes Data and Record the CHAIN name 

1. Select GEOPAK BRIDGE (MicroStation: Applications>GEOPAK BRIDGE>Road 
Tools). 

 

2. Select the Shape Manager tool from the GEOPAK Road tools palette. 

 

3. Select the Shape Analyst tool from the Superelevation Shape Manager Tools palette.  The 
Shape Analyst dialog appears. 

4. Enable the Display Only option. 

5. Click the Dynamic button. Proceed to indicated DP and move the mouse cursor within the 
shapes area. Notice the values displayed in the dialog 

Write in your training manual, the name of CHAIN that appears in the Chain pull down list.  You 
will make references to this chain later in this chapter 
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 Starting GEOPAK Bridge 

1. Select GEOPAK BRIDGE (MicroStation: Applications >GEOPAK BRIDGE > Modeling). 

 

Note If the database is not available, a new one is created. 

 

2. Click OK to proceed. 

3. Select the Configuration Folder VDOT_E. Select Imperial from the Units pulldown. 

 
                   Bridge Configuration selection dialog 

4. Click OK. An Information box appears informing that a Default Bridge database is created. 
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5. Click OK to proceed. The Bridge tools appear as shown below. 

   
Bridge Tools 

STARTING BRIDGE MODELING  

CREATING A NEW BRIDGE 

 Create a new Bridge 

TOOL DESCRIPTION 

 
Project Manager 

 

1. Select the Project Manager tool from the GEOPAK Bridge tools palette. 

 

2. Select the Create Bridge tool. 

3. The Name and Description Editor: Bridge dialog appears. Enter Name “Ellerslie Ave.” 

4. Click OK to proceed. 
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CREATE A BRIDGE SURFACE 
For more information refer to CREATE A BRIDGE SURFACE in Chapter 1 or in the On-Line Help 
(MicroStation: Applications>GEOPAK>BRIDGE>Help). 

. 

 Create a Bridge Surface 

TOOL DESCRIPTION 

 
Surface Manager 

 

Display Z Levels 

1. Select the Surface Manager tool from the GEOPAK Bridge tools palette. 

2. Select the Surfaces Folder. The Surface Manager dialog expands. 

 

Under Surface Data group box: 

3. Select GEOPAK Shapes (Job and Chain) from the Create By pulldown list. 

4. Click Browse and select directory C:\DATA\GEO\VDOT\BRIDGE\ELLERSLIE AVE\. 

5. Select Job300. 

6. Select Ellerslie from the Chain pulldown list. 

7. Right mouse-click anywhere within the Bridge tree list.  Select New> Item.   



Create a Bridge Surface 
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8. The Name and Description Editor: Surface dialog appears. Enter Name “Road Shapes”. 

9. Click OK to proceed. 

 
                            Surface Manager Dialog shown 

10. Select the Display Z Levels tool to browse Z Levels of the selected surface. 

Hint Move the cursor over the surface selected in the list and the corresponding elevations are 
displayed in the Surface Levels dialog. 

 

11. Close the Surface Levels and the Surface Manager Dialog boxes. 



Create/Manage Bridge Location (Alignments, Pier Lines, Beam Layouts and Grids) 
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CREATE/MANAGE BRIDGE LOCATION (ALIGNMENTS, PIER LINES, BEAM LAYOUTS AND GRIDS) 
When the Bridge Location Manager tool is selected the Bridge Location Manager dialog appears. 

After a Bridge is created, folders for Alignments, Pier Locations, Beam Layouts and Grid Lines appear 
in the Bridge Location Manager. The Bridge Location Manager displays a tree view of these folders. 
The Bridge Location Manager dialog expands automatically when the alignments or pier lines folder 
are selected. 

 
  Bridge Location Manager and Folders shown 

CREATE BRIDGE ALIGNMENTS 
Five alignments are created to define the Left Edge, Right Edge, Baseline of the Bridge, Left Face of 
Curb and the Right Face of Curb. 

 Create Bridge Alignment “Ellerslie Ave.”  (Bridge Baseline) 

 

TOOL / OPTION DESCRIPTION 

 
Bridge Location Manager 

 

1. Select the Bridge Location Manager tool from the GEOPAK Bridge tools palette. 

2. Select the Alignments folder. The dialog expands. 

 
     Expanded portion of the dialog shown 
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Under the Alignment Details group box: 

3. Select Offset from GEOPAK Chain from the Method pulldown list. 

4. Click Browse and select directory C:\DATA\GEO\VDOT\BRIDGE\ELLERSLIE AVE\. 

5. Select Job300. 

Under the Horizontal group box: 

6.  Select Ellerslie from the Chain pulldown list. 

7. Enter Offset 0.00 

Under the Bridge Limits group box: 

8. Select the Indicate Start Limit tool.  Indicate a Data Point just inside the beginning of the 
Shapes.  If you wish type 45+00.00 (or 4500.00) in the Start key-in field. 

9. Select the Indicate Finish Limit tool.  Indicate a Data Point just inside the end of the Shapes. 
If you wish type 55+00.00 (or 5500.00) in the Finish key-in field. 

10. Under the Vertical group box, select Not used from the Profile pulldown list 

11. Right mouse-click anywhere within the Bridge tree list.  Select New > Item. 

12. The Name and Description Editor: Alignment dialog appears.  Enter Name “Ellerslie 
Ave.” 

13. Click OK to continue. 

 Set Alignment as Baseline 

 TOOL / OPTION DESCRIPTION 

 
Set alignment as Baseline 

1. Under the Alignments folder, select the Ellerslie Ave icon. 

2. Select the Set alignment as Baseline tool. 
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 Create Face of Curbs Alignments 

Create the Right and Left Face of Curb.  For Method, select Offset from Baseline. The only 
change required is the offset value as shown in table below. 

Note Prior to creating an Alignment, set the Method and Offset 

1. Under the Alignment Details group box, select Offset from Baseline from the Method 
pulldown list 

2. Under the Horizontal group box, change the Offset as indicated in table below. 

3. Select the Create Alignment tool. 

4. The Name and Description Editor: Alignment dialog appears. 

5. Enter Name of Alignments are as Indicated in table below.  

6. Click OK to proceed 

7. Repeat the same process to create the remaining alignments shown below. 

 

Alignment Name Method CHAIN/Alignment/Baseline Offset (+ or -) 

Left Face of Curb Offset from 
Baseline 

Default to Bridge Baseline -30.00 

Right Face of Curb Offset from 
Baseline 

Default to Bridge Baseline 30.00 

 Create the “C/L Railroad” Alignment 

Create the C/L Tracks Alignment.  This alignment can be used when creating a Pier Line 
(Intersect Alignment method) at the intersection of the Bridge Baseline and the intersecting 
alignment. 

1. Under the Alignment Details group box, select Offset from GEOPAK Chain from the 
Method pulldown list. 

Under the Horizontal group box:  

2. Select RAILROAD from the Chain pulldown list. 

3. Check that the Offset is set to 0.00. 

4. Select the Create Alignment tool. 

5. The Name and Description Editor: Alignment dialog appears. 

6. Enter Name “C/L Railroad”. Click OK to proceed. 
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 Create Alignment List “Face of Curbs and Baseline” 

This concept allows for creating groups of alignments. In this exercise an alignment list Face of Curbs 
and Baseline is created. The List is later included in the calculation for Deck Elevations. 

1. Select the List (Alignments) icon. 

 

2. Right mouse-click anywhere within the Bridge tree list.  Select New > Item.  

3. The Name and Description Editor: List of Alignment dialog appears. 

4. Enter Name Face of Curbs and Baseline.  Click OK to proceed. 

Note A Folder Lists (Alignments) and Face of Curbs and Baseline icons are automatically 
created. 

 

5. Select the Face of Curbs and Baseline icon. 

 

6. Right mouse-click anywhere within the Bridge tree list. Select Lists > Add All. 

Note Since all created Alignments are added to the list, alignments that do not describe a Face of 
Curb or the Baseline should be deleted. 

7. Expand the Tree for this List. Click the Plus Sign icon. 

 

Note The Delete tool is also available for selection in the right side of the dialog. 

8. Remove the C/L Railroad alignments from the list using the same procedure. 

 

 

        Alignment List “Face of Curbs and Baseline” shown 
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CREATING PIER LINES AND BEARINGS LINES IN THE BRIDGE LOCATION MANAGER 
There are several methods available to locate a Pier Line: 

 By Station and Skew angle (the Skew Angle can be in degrees, or enable the DMS option to 
define the Skew in degrees, minutes and seconds-space between degrees, minutes and seconds 
is required) 

 By Station and Bearing 

 By Station and Azimuth 

 By Alignment Intersection 

 By selecting an Existing Pier 

 By Picking two Points  

 By Picking Elements (MicroStation lines) 

At each Pier Line location, Bearing Line Data back and ahead of the pier line is defined by entering 
offset values (normal distances) to the pier line and by the selecting the bearing type - Expansion or 
Fixed support. 

The first pier line that needs to be defined is the Interior pier so it can be used as a reference to create 
the locations and directions of Abutment A and Abutment B. In this exercise, the Topo.dgn file shows 
the local conditions and is used in determining the preliminary location and skew angle of the interior 
pier.  

The location and direction of the Interior Pier is first defined by drawing a MicroStation line running 
through the middle of the Creek. The MicroStation line element is then analyzed by Bridge to create 
the preliminary pier line. 

When the pier line is located, you can review the Station, Skew, Bearing, Azimuth data, using the 
Bearing/Azimuth/Skew/DMS Display Mode tool. You can also change the Station, or Skew, or 
Bearing values as required and select the Update Pier Line tool to finalize the changes to the Pier Line 
location. 

 Prepare Reference File “14652Rev.dgn”  (Topo file) 

1. Select the References tool. Locate it in the MicroStation Primary Tools. 

2. Select Attach Reference tool. 

 

3. Select the file C:\DATA\GEO\VDOT\BRIDGE\ELLERSLIE AVE\14652Rev.dgn 

4. Enter Logical Name Topo. 

5. Click OK. 
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 Prepare Level Display 

1. Select the MicroStation Display Level tool. 

       

2. Select the 14652Rev.dgn icon as shown above. 

3. Right mouse-click anywhere within the Level Display list. Select option All Off. 

 

4. Turn On Levels Ballast and Railroad by locating them in the Display list and highlighting 
the Level. 

 

5. Close the Level Display dialog box. 
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CREATE “PIER 1” 
The purpose of this exercise is to create a Bridge Pier line from an existing MicroStation line. 

 Create  Preliminary Location of Interior ” Pier 1” 

1. Draw a straight Line that approximates the C/L of the tracks near the vicinity of the 
intersection of the Bridge Baseline and the C.L. of the Railroad tracks. 

Note In this step, a line has been already drawn for uniformity of the Class. Turn On Level 46. 

 

2. Move the line Parallel 38.0 ft towards the left side. As shown above. 

Note This line is located at 38.0 ft to comply with design Clearance requirements. 

3. Select the Pier Lines folder. The dialog expands. 

Under Pier Lines Location data group box: 

4. Select Station and Skew Angle from the Location Method pulldown list. 

5. Click Pick Elements.   

6. Select the MicroStation Line.  Accept the selection. 

7. Select the Create new Pier Line tool. 

8. The Name and Description Editor: Pier Line dialog appears. Enter Name Pier 1.  Click OK 
to continue. 

9. Under the Pier Line Location Data group box, change the station value to 50+72.00. 

Note Assume you decide that for this example, the Station was 50+72.00. 
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 Define Bearing Line Data 

Under the Bearing Line Data group box: 

1. Select Fixed from the Back pulldown list. 

2. Enter Offset 0.0. 

3. Select No Bearing from the Ahead pulldown list. 

4. Select the Modify Pier Line tool to update the changes. 

CREATE “ABUTMENT A” 

 Create  Pier Line “Abutment A” Pier Line 

It is decided “Abutment A” is to be located 47 ft along the baseline from Pier 1. Use the Existing 
Pier option. 

Under Pier Lines Location Data group box: 

 

1. Select Existing Pier (distance along Baseline) from the Location Method pulldown list. 

2. In the Relative Distance key-in field, enter -47 ft. 

3. Enable the Parallel option (parallel to existing pier). 

Note Enabling the Parallel option forces the Skew key-in field value to change to zero. The Skew 
value in this situation specifies an additional skew added to that of the Existing Pier. 

4. Select “Pier 1” icon from the Pier Name pulldown list. 

 Define Bearing Line Data 

Under the Bearing Line Data group box: 

1. Select No Bearing from the Back pulldown list. 

Note The Offset value defaults to zero. 

2. Select Expansion from the Ahead pulldown list. 

3. Enter Offset 2.2291 ft for Ahead (this corresponds to the offset of 2’-3 ¼” adjusted normal to 
the End of Slab). 

4. Select the Create new Pier Line tool.   

5. The Name and Description Editor: Pier Line dialog appears. 

6. Enter Pier Name Abutment A. 

7. Enter Description End of Slab. Click OK to continue. 
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8. Select the Bearing/Azimuth/Skew/DMS Display Mode tool to set the display view to 
Bearing, Azimuth, Skew, or DMS. 

Note Select the Bearing/Azimuth/Skew/DMS Display Mode tool and click several times. Notice in 
the dialog tree next to each pier name, the value changes each time the 
Bearing/Azimuth/Skew/DMS Display Mode tool is selected. 

CREATE REMAINING PIER LINES 

 Create Pier Lines for “Pier 2” and “Abutment B” 

Proceed to create “Pier 2” and “Abutment B” pier lines using the information shown in the table 
below.  Note that the Stations are measured along the Baseline. “Pier 2” is to be located 76.0 ft. 
from “Pier 1” and “Abutment B” is to be located 123.0 ft. from Pier 1. 

The only changes required are the Relative distance and the Bearing Line Data. 

 

Pier Line Name Pier 2 Abutment B 

Pier Location Method Existing Pier (distance along Baseline) Same as for Pier 2 

Relative Distance 76 ft 123 ft 

Bearing Back type Expansion Expansion 

Bearing Back Offset 0.0 2.2291 

Bearing Ahead type No Bearing No Bearing 

Bearing Ahead Offset 0.0 0.0 

Pier Description 
- End of Slab 

 

1. Select existing pier Abutment A icon. 

 

2. Under the Pier Line Data group box, change the Relative Distance. 

3. Under the Bearing Line Data group box, change the Bearing Line Data. 

4. Select the Create new Pier Line tool. 

5. The Name and Description Editor: Pier Line dialog appears. 

6. Enter Pier Name. 

7. Click OK to continue. 

8. Repeat these steps to create the additional pier lines. 
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CREATE LONG CHORD, LEFT EDGE AND RIGHT EDGE ALIGNMENTS 
From the previous exercise, you created the Abutment A and Abutment B pier lines. Now it is possible 
to create the Long Chord, Left Edge and Right Edge alignments, using the Long/Short Chords 
between piers method. The Left Edge and Right Edge alignments are parallel to the Long Chord. 

The Long Chord alignment is required later in this example, to review the angle between the Long 
Chord and Pier 1 center line. 

 Create the Long Chord Alignment 

1. Select the Alignments folder. 

Under the Alignment Details group box: 

 

2. Select Long/Short Chord between Piers from the Method pulldown list. 

Under the Horizontal group box: 

 

3. Select Ellerslie Ave Alignment from the pulldown list. 

4. Enable the Long Chord option. 

5. Check that the Offset is set to 0.0. 

6. Select Abutment A icon from the Start Pier pulldown list. 

7. Select Abutment B icon from the End Pier pulldown list. 

8. Select the Create Alignment tool. 

9. The Name and Description Editor: Alignment dialog appears. 

10. Enter Name “Long Chord”. 

11. Click OK to proceed. 
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 Create the Deck Left and Right Edge Alignments. 

1. Select the Alignments folder. 

2. Under the Alignment Details group box, select Long/Short Chord between Piers from the 
Method pulldown list. 

Under the Horizontal group box: 

3. Select Ellerslie Ave Alignment from the pulldown list. 

4. Enable the Long Chord option. 

5. Enter the Offset as shown in Table below. 

6. Select Abutment A from the Start Pier pulldown list. 

7. Select Abutment B from the End Pier pulldown list. 

8. Select the Create Alignment tool. 

9. The Name and Description Editor: Alignment dialog appears. 

10. Enter Name of Alignment as shown in Table below. 

11. Click OK to proceed. 

12. Repeat the same process to create the remaining alignments shown in the table below. 

 

Alignment Name Method Offset (+ or -) 

Left Edge Long/Short Chord between 
Piers 

-39.2500 

Right Edge Long/Short Chord between 
Piers 

39.2500 
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REVIEW ANGLE BETWEEN LONG CHORD AND PIER 1 CENTER LINE 
As previously stated, the original design of this example used the Long Chord procedure to define the 
skew angle of the first pier. Therefore, pier lines must be created before the Long/Short Chord 
between Piers method is used. 

This process is an iterative one. In the preliminary stage, after the first pier is located, Abutment A, 
Pier 2 and Abutment B are first located. With the station of the piers finalized, you can proceed to 
review the angle between Pier 1 and the Long Chord and make the final determination on the skew 
angle of Pier 1. 

Assume you decide the angle between the Chord and Pier 1 is to be rounded off. 

Use the MicroStation Measure Angle Between Lines tool to measure the angle between the Long 
Chord and Pier 1 centre line. 

 Check Angle Between the Long Chord and “Pier 1” Center Line 

1. Select the MicroStation Measure Angle Between Lines tool. Select the Long Chord and 
Pier 1 center line elements. 

Note The angle between the Chord and the pier line reads 77ˆ 53’ 39”. Subtracting 90ˆ from 77ˆ 
53’ 39” equals 12ˆ 6’ 21” (which is the skew angle between the Long Chord and the Pier 
Line). Therefore, the bearing direction of “Pier 1” needs to be adjusted by 1ˆ 6’ 21” thereby 
maintaining an 11ˆ difference. 

2. Select Pier 1 icon from the Bridge tree list. 

3. Under the Pier Location Data group box, change the Skew value to 11^ 13’ 32.04”. 

Note Under the Pier Lines Location Data, the skew angle reads 12ˆ 19’ 53.04”.  Subtract 1ˆ 6’ 21” 
from 12ˆ 19’ 53.04” equals to 11ˆ 13’ 32.04”.  This value is the final Skew Angle of Pier 1.  
Since the Abutment A, Pier 2 and Abutment B were located based on Pier 1, their skew 
angles will update automatically.  

4. Select the Modify Pier Line tool to update the changes. The Bridge Location Manager should 
appear as follows. 

 

5. Select the Update the Bridge Drawing tool.  Locate it in the Bridge Drawing Update tools. 
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CREATING BEAM LAYOUTS AND BEAM LINES 

CREATE BEAM LAYOUTS FOR “BEAMS SPAN A THRU C” 
Girders are continuous and beam lines are parallel to the Long chord. 

 Create Layout for “Beams Span A thru C” 

1. Select Beam Layouts folder. 

2. Select the Create Beam Line tool. 

3. The Name and Description Editor: Beam Layout Group dialog appears. 

4. Enter Name “Beams Span A thru C”.  Click OK to continue 

CREATE BEAM LINES FOR “BEAMS SPAN A THRU C” 

 Define the First Beam 

1. Select beam layout Beams Span A thru C icon. The dialog expands. 

Under the Beam Group Specifications group box: 

 

2. Enable the Continuous Beam Arrangement option. 

3. Select Long Chorded from the Beam Geometry pulldown list. 

4. Select Abutment A icon from the Start Pier pulldown list. 

5. Select Abutment B icon from the End Pier pulldown list. 

6. Click First Beam tab to define the First Beam. 

7. Select Baseline Alignment from the Method pulldown list. 

Note In this example, all the beams are placed parallel to the Long Chord of the baseline at a zero 
offset. Therefore, you MUST enable the Parallel to Chord option. 

8. Change Offset to -36.0 ft 

9. Under the First Beam tab, enable the Parallel to chord option. 

Note It is not necessary to define the Last Beam when all beams are parallel to each other.  Under 
the Spacing tab, select method Exact Spacing and Number. The Spacing can be a negative 
value, indicating beams are spaced towards the left of the first beam. Other options are 
available as discussed in earlier chapters. 
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 Define the Beam Spacing 

10. Click the Spacing tab to define the Beam Spacing. 

 

11. Select Method Exact Number and Spacing. 

12. Enter Number 10 in the Number field. 

13. Enter Spacing 8.0 in the Spacing field. 

14. Select the Modify Beam Line tool to update the changes. 

Note Beams appear in the design file. They are parallel to each other. 
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SET GRID LAYOUTS PROPERTIES 
Different properties options are available to Display, Design and Reporting Grid Layouts. 

 Set or Review Grid Layouts Display Properties 

1. Select the Properties Manager tool from the GEOPAK Bridge tools palette. 

Note The properties shown in the GEOPAK Bridge – Properties Manager dialog are from the 
default properties stored in the default template. The default values are automatically 
transferred from the default template to the current project when a Bridge Database is 
created. 

2. Under Bridge Locations select Grid Layouts icon. Under Grid Layouts select the Display 
icon.  The dialog changes as shown below. 

Hint Notice that the Project Properties tree can be collapsed and expanded by clicking on the + or 
– icons. You can use the vertical scroll bar to browse the tree. 

 

The defaults settings under Levels, Line Elements, Text Elements and Plans Production should be 
the same as the ones shown above. 
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 Set or Review Grid Layouts Grid Heights Design Properties 

1. Under Bridge Locations icon select the Grid Heights icon > Design icon. The dialog changes 
as shown below. 

 

2. Check that under the Grid Height Properties, the Surface Elevations Only from the Surface 
Calculation Mode pulldown list is selected. 

3. Click the X top right corner to close the dialog. 
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CREATE GRID LAYOUTS AND GRID LINES FOR BEAMS 
One Grid layout Group is created in this exercise. The Elevations shown in the pictures depicted below 
were extracted from existing plans. 

 

 Create Grid Layout for “Spans A thru C” 

1. Select the Grid Layouts folder in the Bridge Location manager. 

2. Select the Create Grid tool. 

3. Name and Description Editor: Grid Group dialog appears. 

4. Enter name “Spans A thru C”. Click OK to proceed. 

 Create Grid Lines for “Spans A thru C” 

1. Select the Grid Layout Spans A thru C icon. The dialog expands. 

2. Under the Grid Specifications group box, select Beams Span A thru C from the Beam 
Layout pulldown list. 

 

Note Notice that under the Grid Specifications the Start Pier, Number of Spans and End Pier are 
automatically selected. The information was extracted from the data that was used when the 
Beam Layout Spans A thru C was created 

Under the Grid Layout Data group box: 

 

3. Select Parallel Back Pier from the Layout Method pulldown list. 

4. Select Along Ref Alignment - between Bearings from the Division of Span pulldown list. 



Create Grid Layouts and Grid Lines for Beams 

 

VDOT Bentley Bridge Training Manual 2004 Edition 
6/8/2006 4-29 

5. Select Along Grid Line from the Display Mode pulldown list. 

6. Enter Distribution 5 and select Fraction from the Distribution pulldown list. 

7. Select No Pier Lines from the Pier Mode pulldown list 

8. Select Both Bearing Lines from the Bearing Mode pulldown list. 

9. Select Ellerslie Ave from the Reference Alignment pulldown. 

At the bottom of Grid Specifications box: 

 

10. Select None Selected from the Alignments pulldown list.   

11. Select Road Shapes from the Elevation Surface pulldown list. 

12. Select the Modify Grid tool to update the changes. 

Note Elevations are now calculated and drawn in the DGN file. If Elevation values are not 
displayed, execute a Fit View of the MicroStation window. 
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CREATE GRID LAYOUTS AND GRID LINES FOR “FACE OF CURBS AND BASELINE” 
In this exercise, Faces of Curb are divided in four equal spaces between Pier Lines at Span A and C, 
and five equal spaces in Span B. 

One Grid layout Group is created in this exercise. The Second span needs to be modified since the 
number of Grid lines is different than in the exterior spans. 

 

 

        Table from existing plans shown 

 Create Grid Layout for “Face of Curbs and Baseline” 

1. Select the Span A thru C icon under the Grid Layouts folder. The information is used as 
basis to create a new layout. 

2. Select the Create Grid tool. 

3. Name and Description Editor: Grid Group dialog appears. 

4. Enter name Face of Curbs and Baseline. 

5. Click OK to proceed. 
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 Create Grid Lines for “Face of Curbs and Baseline” 

The grid layout Face of Rails and Baseline icon is automatically highlighted and the dialog 
remains expanded.  Few changes are required here. 

1. Under the Grid Specifications group box, select None Selected from the Beam Layout 
pulldown list. 

 

Under the Grid Layout Data group box: 

 

2. Select Along Ref Alignment - between Piers from the Division of Span pulldown list. 

3. Enter Distribution 4. 

4. Select Both Pier Lines from the Pier Mode pulldown list. 

5. Select No Bearing Lines from the Bearing Mode pulldown list. 

Under the Grid Specifications group box: 

6. Select Face of Curbs and Baseline icon from the Alignments pulldown list as shown below. 

 

7. Select the Modify Grid tool to update the changes. 

Note Automatically, the Elevations are calculated and drawn in the DGN file. Notice Span B has 
only four Grid lines.  In this exercise, Span B requires 5 equal spaces. 
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MODIFY A GRID LAYOUT WITHIN A SPAN 

 Modify the Interior Grid Layout in Span B between Pier 1 to Pier 2 

This exercise is to modify the second span Grid distribution by using the Use local Grid 
specifications at this span option. 

1. Select Face of Curbs and Baseline icon. 

2. Expand the Tree for this Grid by Clicking the Plus Sign icon. 

3. Under the Face of Curbs and Baseline icon, select [Pier 1 -> Pier 2] icon (the second span). 

 

4. Under the Grid Specifications group box, enable the Use local Grid specifications at this 
span option.  

5. Under the Grid Layout Data group box, enter Distribution 5. 

6. Select the Modify Grid tool to update the changes. 
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CREATE REPORTS 
For more information refer to REPORTS in Chapter 1 or in the On-Line Help MICROSTATION 
(Applications>GEOPAK>BRIDGE>Help). 

REPORTS MANAGER 
The Report Manager is used to manage the output of Text, CSV and XML files. It is also used to 
manage the updating, deleting, re-sequencing and displaying of reports 

PROCEDURE 
Reports are created by using both the Properties Manager and the Reports Manager. 

1. The Reports Manager is where output files are managed. 

2. The Properties Manager tool is where reports are activated and where Report Templates are 
selected. 

REPORTS MANAGER 
The Report Manager is used to manage the output of Text, CSV and XML files. It is also used to 
manage the updating, deleting, re-sequencing and displaying of reports. 

 Create a Report Set 

1. Select the Reports Manager tool from the GEOPAK Bridge tools palette. The GEOPAK 
Bridge – Reports Manager dialog appears. 

 

2. Select the Create Reports Set tool. 

3. The Name and Description Editor: Bridge Component dialog appears. Enter Name “Ellerslie 
Ave.”. 

4. Click OK to proceed. 

 

 



Reports Manager 
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5. Select the Ellerslie Ave icon. The dialog expands. 

 

6. Under Report Output Modes, enable the Text File option. 

 

7. Select the Select Text File tool. The default directory appears. Under Files enter “Report”. 

          

8. Click OK to continue. 

 



Reports Manager 
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9. Select the Modify Reports Set tool to update the changes. 

 

10. Expand the Ellerslie Ave. tree. Select the Text icon as shown below: 

 

Warning DO NOT CLOSE THE REPORTS MANAGER DIALOG. We need to proceed with the 
Properties Manager to enable the reports properties. 
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ACTIVATE REPORTS IN THE BRIDGE PROPERTIES 

 Activate Pier Lines Report 

1. Select the Properties Manager tool from the GEOPAK Bridge tools palette. 

2. Under the Bridge Locations icon, select the Pier Lines icon.  

3. Under the Pier Lines icon select the Reports icon 

 

                                        Global Bridge Properties dialog shown 

4. Under Reports window, select Ellerslie Ave from the Name pulldown list. 

5. Select Modify Report tool from the right side of the dialog. 

 Activate Grid Layouts Report 

1. Under the Grid Layouts icon, select the Reports icon. 

2. Under the Reports window, select Ellerslie Ave from the Name pulldown list. 

3. Select Modify Report tool. 
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 Activate Grid Heights Report 

1. Under the Grids Heights icon, select the Report icon. 

2. Under Reports window, select Ellerslie Ave from the Name pulldown list. 

3. Select Update Report tool. 

 

Report activated for Grid Heights shown 

4. Close the Bridge Properties dialog. 
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UPDATE REPORT 
When reports are activated in the Bridge Properties dialog, the Report Manager processes the report. 

 Update Report 

1. Proceed to locate the Reports Manager dialog. 

 

2. Select the Update Report tool.  Wait for processing. 

Note The report is automatically displayed. To view the report at any time, select the Display Report 
tool. 

The Grid report is partially shown below. 

 
Part of Grid Report Shown 



Update Report 

 

VDOT Bentley Bridge Training Manual 2004 Edition 
6/8/2006 4-39 

The design file should appear as shown below. 

Warning If Elevation values are not displayed, Fit View the MicroStation window. 

 

 
Un-Rotated Plan view of Bridge shown 
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 5 
OBJECTIVES 

Develop the Bridge model for University Blvd Bridge. 

The horizontal alignment is on a tangent and the bridge is on a hump vertical curve. There is 
Superelevation transition to the right of the baseline for part of span and the rest of the bridge is 
crowned at ¼” per foot. There is no skew. The span layout is 130’-176’-169’ continuous steel plate 
girders. The bridge has an open longitudinal joint in the raised median. Girder D is offset 3’-1½” left 
of the baseline, and girder E is offset 3’-4” right of the baseline. The rest of the girders are spaced at 
10’-2”. 

REFERENCE MATERIAL 
Units: Imperial 

Steel Girders 

Profile: 

CG Sta. 38+00.000 EL 391.94 VC = 975.00 g1 4.55 % g2 -4.2 %  

GPK file available: JOB400 

Shapes available: Shapes.dgn 

Survey Base Line available: UBLVD 

Profile Grade Line available: UBDVD 

Cross Slope: 2.08% CROWNED * 

Note * North Bound bridge cross slope Varies from -1.511 % @ Sta. 37+28.50 to -2.08 % @ Sta.  
37+53.67 

Modeling DGN file available: C:\DATA\GEO\VDOT\Bridge\University Blvd\University3D.dgn 

   University Blvd. Bridge 



Plan View and Section on C.L. 
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PLAN VIEW AND SECTION ON C.L. 

:  

 



Transverse Section (South Bound Bridge Shown) 
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TRANSVERSE SECTION (SOUTH BOUND BRIDGE SHOWN) 

 

 



Transverse Section (North Bound Bridge Shown) 
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TRANSVERSE SECTION (NORTH BOUND BRIDGE SHOWN) 

 

 



Detail Between North and South Bound 
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DETAIL BETWEEN NORTH AND SOUTH BOUND 

 
Partial Section 2” opening shown 

 

 

 

 



Framing Plan Span A 
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FRAMING PLAN SPAN A 

 



Starting The Bridge Model For the South Bound 
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STARTING THE BRIDGE MODEL FOR THE SOUTH BOUND 

 Open University3D.dgn and Attach as Reference the Shapes.dgn file 

1. Open C:\Data\Geo\VDOT\Bridge\University Blvd\University3D.dgn 

2. Select References tool. 

3. Select Attach Reference tool. 

4. Select C:\Data\Geo\VDOT\Bridge\University Blvd\Shapes.dgn 

5. Enter for Logical Name Shapes. 

6. Click OK. 

7. Close the References dialog box. 

 Select the Road Project Using the Road Project Manager 

1. Select the Road Project Manager tool. The Project Manager dialog box appears. 

2. Under the Directories list box, select C:\DATA\GEO\VDOT\BRIDGE. 

3. Under the Projects list box, select University.prj.  The Project Users dialog box appears. 

Note Record in your manual, the Job Number shown in the dialog. 

4. Under the Project Users list box select your name from the list of users. 

Warning If your name is not available, contact your project administrator. 

5. Click OK to continue. 

6. Minimize the Road Project dialog box. 

 Check the Shapes Data and Record the CHAIN name 

1. Select GEOPAK BRIDGE (MicroStation: Applications>GEOPAK BRIDGE>Road 
Tools). 

 

2. Select the Shape Manager tool from the GEOPAK Road tools palette. 

 

3. Select the Shape Analyst tool from the Superelevation Shape Manager Tools palette.  The 
Shape Analyst dialog appears. 

4. Enable the Display Only option. 

5. Click the Dynamic button. Proceed to indicated DP and move the mouse cursor within the 
shapes area. Notice the values displayed in the dialog 

Write in your training manual, the name of CHAIN that appears in the Chain pull down list.  You 
will make references to this chain later in this chapter 
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 Starting GEOPAK Bridge 

1. Select GEOPAK BRIDGE (MicroStation: Applications>GEOPAK BRIDGE>Modeling). 

Note if the database is not available, Bridge will prompt to create a new one. 

2. Click OK to proceed. 

3. Select the Configuration Folder VDOT_E.  Select for Units Imperial. 

 
        Bridge Configuration selection dialog 

4. Click OK. An Information box appears informing that a Default Bridge database is created.  

5. Click OK to proceed. 

6. The Bridge tools appear. The Bridge tools appear as shown below. 

  
         Bridge Tools 

 

  



Starting Bridge Modeling 
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STARTING BRIDGE MODELING  

CREATING A NEW BRIDGE 

 Create a new Bridge 

TOOL DESCRIPTION 

 
Project Manager 

 

1. Select the Project Manager from the GEOPAK Bridge tools palette. 

 

2. Select the Create Bridge tool located in the right side of the dialog. 

3. The Name and Description Editor: Bridge dialog appears. Enter Name “University Blvd”. 

4. Click OK to proceed. 



Create a Bridge Surface 
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CREATE A BRIDGE SURFACE 
For more information refer to CREATE A BRIDGE SURFACE in Chapter 1 or in the On-Line Help 
(MicroStation: Applications>GEOPAK>BRIDGE>Help). 

. 

 Create a Bridge Surface 

TOOL DESCRIPTION 

 
Surface Manager 

 

Display Z Levels 

1. Select the Surface Manager tool from the GEOAPK Bridge tools pallete. 

2. Select the Surfaces Folder. The Surface Manager dialog expands. 

Under the Surface Data group box: 

3. Select GEOPAK Shapes (Job and Chain) from the Create By pulldown list. 

4. Click Browse and select directory C:\DATA\GEO\VDOT\BRIDGE\UNIVERSITY 
BLVD\ 

5. Select Job400. 

6. Select UBLVD from the Chain pulldown list. 

7. Right Mouse-click anywhere within the Bridge tree list. Select New> Item. 

8. The Name and Description Editor: Surface dialog appears. Enter Name “Road Shapes”. 



Create/Manage Bridge Location (alignments, pier lines, beam layouts and grids) 
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9. Click OK to proceed. 

 
         Final Surface Manager Dialog shown 

10. Select the Display Z Levels tool, to browse elevations (Z Levels) of the selected surface. 

Hint Move the cursor anywhere over the selected surface and the corresponding elevations are 
displayed in the Surface Levels dialog. If the point indicated is outside of the surface, Bridge 
will display that the point is Outside of the Surface. 

 

11. Close the Surface Levels and the Surface Manager Dialog boxes. 

CREATE/MANAGE BRIDGE LOCATION (ALIGNMENTS, PIER LINES, BEAM LAYOUTS AND GRIDS) 
The Bridge Location Manager is responsible for the primary locations for all aspects of your bridge 
models. Alignments for the bridge deck and beams etc. are registered within the Location Manager. 
Pier line locations are chosen along the appropriate baseline alignment. Single span and continuous 
span beam layouts (their centerlines) are established with reference to the alignments and selected Pier 
locations. Grid patterns are developed and superimposed on beam layouts to generate deck elevations. 

These locations represent the basis for the bridge layout. For maximum ease of use, they are created 
entirely within the X/Y plane (top view) and require no 3D modeling information or input 

When the Bridge Location Manager tool is selected the Bridge Location Manager dialog appears. 

After a Bridge is created, folders for Alignments, Pier Locations, Beam Layouts and Grid Lines appear 
in the Bridge Location Manager. The Bridge Location Manager displays a tree view of these folders. 
The Bridge Location Manager dialog expands automatically when the alignments or pier lines folder 
are selected. 

CREATE BRIDGE ALIGNMENTS SOUTH BOUND 
From information shown in the cross section for this bridge, five alignments are created to define the 
Left Edge, the Right Edge, and the Baseline of the Bridge, the Left Face of Curb and the Right Face of 
Median Curb 



Create Bridge Alignments South Bound 
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 Create Bridge Alignment “University Blvd” (Bridge Baseline) 

1. Select the Bridge Location Manager tool. 

2. Select Alignments folder. The dialog expands. 

Under the Alignment Details group box: 

3. Select Offset from GEOPAK Chain from the Chain pulldown list. 

4. Click Browse and select directory C:\DATA\GEO\VDOT\BRIDGE\UNIVERSITY LVD\. 

5. Select Job400. 

Under the Horizontal group box: 

6. Select UBLVD from the Chain dropdown list. 

7. Enter Offset 0.00. 

8. Under the Bridge Limits group box: 

9. Select Indicate Start Limit tool. Indicate a Data Point just inside the beginning of the 
Shapes. 

10. Select Indicate Finish Limit tool.  Indicate a Data Point just inside the end of the Shapes. 

11. Under the Vertical group box, select Not used from the Profile dropdown list. 

12. Select the Create Alignment tool, from the right side of the dialog. 

13. The Name and Description Editor: Alignment dialog appears. Enter Name “University 
Blvd”. 

14. Click OK to proceed. 



Create Bridge Alignments South Bound 
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 Set Alignment as Baseline 

  

TOOL / OPTION DESCRIPTION 

 
Set alignment as Baseline 

 

1. Under the Alignments folder, select Alignment University Blvd. 

2. Select the Set alignment as Baseline tool. 

 Create Additional Bridge Alignments 

Create the rest of the Alignments using the information shown in the Table below. Also, use as 
reference, similar steps for creating alignments in chapter 1 through 3. Change items in the dialog as 
required prior to creating the alignment. 

1. Under the Alignment Details group box, select Offset from Baseline from the Method 
pulldown list. 

2. Under the Horizontal group box, change the Offset as indicated in table below. 

3. Select the Create Alignment tool. 

4. The Name and Description Editor: Alignment dialog appears. 

5. Enter Name of Alignments are as Indicated in table below. 

6. Click OK to proceed. 

7. Repeat the same process to create the remaining alignments shown below. 

 

Alignment Name Create By CHAIN/Alignment/Baseline Offset (+ or -) 

Left Edge of Deck Offset from 
Baseline 

Default to Bridge Baseline -36.6667 

Left Face of Curb Offset from 
Baseline 

Default to Bridge Baseline -35.000 

Right Edge of Deck Offset from 
Baseline 

Default to Bridge Baseline -0.0833 

Right Face of 
Median Curb 

Offset from 
Baseline 

Default to Bridge Baseline -8.00 
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 Create Alignment List “Face of Curbs  and Baseline” 

This exercise is to create an Alignment List named Face of Curbs and Baseline. 

1. Select List (Alignments) icon. 

2. Anywhere within the dialog box, Right Mouse-click.  Select New > Item. 

3. The Name and Description Editor: List of Alignment dialog appears. 

4. Enter Name “Face of Curbs and Baseline”.  Click OK to proceed. 

Note A Folder Lists (Alignments) and Face of Curbs and Baseline icons are automatically 
created. 

5. Select the Face of Curbs and Baseline icon. 

6. Anywhere within the dialog box, Right Mouse-click.  Select Lists > Add All. 

Note Since all created Alignments are added to the list, alignments that do not describe a Face of 
Curb or the Baseline should be deleted. 

7. Expand the Tree for this List. Click the Plus Sign icon. 

8. Select Left Edge of Deck from the list. 

9. Select the Delete tool, to remove from the list. 

10. Select Right Edge of Deck from the list. 

11. Select the Delete tool, to remove from the list. 
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CREATE PIER LINES 
Create the Pier Lines using as the steps described in chapter 1 through 3. Also, use the On-Line Help 
MicroStation: (Applications>GEOPAK>BRIDGE>Help). 

 Create Pier Lines 

Create the Pier Lines using the information shown in the Table below. 

 

 Abutment A Pier 1 Pier 2 Abutment B 

Location Method Station and 
Skew Angle 

Station and 
Skew Angle 

Station and 
Skew Angle 

Station and 
Skew Angle 

Station 37+28.50 38+ 58.50 40+34.50 42+03.500 

Skew 0.0 0.0 0.0 0.0 

Bearing Line Data 
Back 

No Bearing Fixed Fixed Expansion 

Bearing Back 
Offset 

0.0 0.0 0.0 1.25 

Bearing Line Data 
Ahead  

Expansion No Bearing No Bearing No Bearing 

Bearing Ahead 
Offset 

1.25 0.0 0.0 0.0 

Pier Line Name Abutment  A 
Pier 1 Pier 2 Abutment  B 

Pier Description Face of 
Backwall - - Face of 

Backwall 

1. Select the Pier Lines folder. 

Under the Pier Line Location Data group box: 

2. Select the Station and Skew Angle from the Location Method pulldown list. 

3. Change Station value. 

Under the Bearing Line Data group box: 

4.  Change the Offset Back and Ahead. 

5. Right mouse-click anywhere within the Bridge tree list.  Select New > Item. 

6. The Name and Description Editor: Pier Line dialog appears. Enter Pier Name. 

7. Click OK to continue. 

8. Repeat steps above to create the additional pier lines. 
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CREATE GIRDER LAYOUTS AND GIRDER LINES FOR “GIRDERS SPAN A THROUGH C” 
The Girders are parallel to the baseline and are continuous. 

MODIFY THE DEFAULT REGULAR BEAM LINES NAMING PATTERN 
The default naming pattern is Beam {@}. In this exercise you need to change the pattern from Beam 
{@} to Girder {@}. You need to select the Properties  Manager tool to make this modification. 

 Change Pattern from Beam {@} to Girder {@} 

1. Select the Properties Manager from the GEOPAK Bridge tools palette. The GEOPAK 
Bridge-Properties Manager: [GLOBAL] appears. 

 

2. Under the Bridge Locations icon, select the Beam Layouts icon > Design icon. 

 

 



Modify the Default Regular Beam Lines Naming Pattern 
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3. Under the Select Naming Category group box, select Regular Beam Lines from the Category 
pulldown list. 

 

4. Under the Naming Pattern group box, Change from Beam {@} to Girder {@}. 

5. Close the Properties Manager dialog box. 



Create Girder Layouts for “Girders Span A through C” 
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CREATE GIRDER LAYOUTS FOR “GIRDERS SPAN A THROUGH C”   

 Create  Beam Layout for “Beams Span A through C” 

1. Select the Beam Layouts folder. 

2. Select the Create Beam Line tool. 

3. The Name and Description Editor: Beam Layout Group dialog appears. 

4. Enter Name “Girders Span A through C”. 

5. Click OK to continue. 

CREATE GIRDER LINES FOR “GIRDERS SPANS A THROUGH C” 

 Define the First Beam 

1. Select beam layout Girders Span a through c. The dialog expands. 

Under the Beam Group Specifications group box: 

 

2. Enable the Continuous Beam Arrangement option. 

3. Select Concentric/Parallel from the Beam Geometry pulldown list. 

4. Select Abutment A from the Start Pier pull down. 

5. Select Abutment B from the End Pier pull down. 

6. Click First Beam tab to define the First Beam. 

7. Select Baseline Alignment from the Method pulldown list. 

Note In this example it is not REQUIRED to enable the Parallel to Chord option because the 
Baseline is already a straight line. Therefore all the beams will be placed parallel to the 
baseline. 

8. Change Offset to -33.6250 ft. 



Create Girder Lines for “Girders Spans a through C” 
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 Define the Last Beam 

Under the Beam Group Specifications group box: 

 

1. Click Last Beam tab to define the Last Beam. 

2. Enable the Active option to define the Last Beam. 

3. Select Baseline Alignment from the Method pulldown list. 

4. Change the Offset to -3.125 ft. 

 Define the Beam Spacing 

Under the Beam Group Specifications group box: 

 

1. Click the Spacing tab to define the Beam Spacing. 

2. Select Number from the Method pulldown list. 

3. Enter 4 in the Number field. 

4. Select the Modify Beam Line tool to update the information. 



Create Grid Layouts and Grid Lines for Calculating Elevations 
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CREATE GRID LAYOUTS AND GRID LINES FOR CALCULATING ELEVATIONS 
Two Grid layout Groups need to be created - one for the Girders and the other for the Faces of Curbs 
and Baseline. 

CREATE GRID LAYOUTS AND GRID LINES FOR GIRDERS 
One Grid layout Group is created in this exercise. The Second span needs to be modified since the 
number of Grid lines is different from the exterior spans. 

The pictures depicted below were extracted from existing plans. Girder Elevations A through D are for 
the Southbound Bridge and Girder Elevations E through I are for the Northbound Bridge. 

SPAN A 

 

 SPAN B 

 

 SPAN C 
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CREATE GRID LAYOUT FOR “GIRDERS SPAN A THROUGH C” 

 Create Grid Layout for “Girders Span A thru C” 

1. Select the Grid Layouts folder. 

2. Select the Create Grid tool. 

3. Name and Description Editor: Grid Group dialog appears. 

4. Enter name Girders Span A through C. 

5. Click OK to proceed. 

CREATE GRID LINES FOR “GIRDERS SPAN A THROUGH C” 

 Create Grid Lines for “Girders Span A thru C” 

1. Select the Grid Layout Girders Span a thru c icon. The dialog expands. 

2. Under the Grid Specifications group box,  select Girders Span a through c icon from the 
Beam Layout pulldown list 

Note Notice that under the Grid Specifications the Start Pier, Number of Spans and End Pier are 
automatically selected. 

 

Under the Grid Layout Data group box: 

 

3. Select Parallel Back Pier from the Layout Method pulldown list. 

4. Select Along Ref Alignment-between Bearings from the Division of Span pulldown list. 

5. Select Along Grid Line from the Display Mode pulldown list. 

6. Enter Distribution 10 and select Fraction from the pulldown. 

7. Select No Pier Lines from the Pier Mode pulldown list. 

8. Select Both Bearing Lines from the Bearing Mode pulldown list. 

9. Select University Blvd from the Reference Alignment pulldown. 

Under the Grid Specifications group box: 

10. Select None Selected from the Alignments pull down list. 

11. Select Road Shapes from the Elevation Surface pulldown list. 

12. Select None Selected from the Clearances Surface pull down list. 

13. Select the Modify Grid tool to update the changes. 



Create Grid Lines For “Girders Span A through C” 
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CREATE GRID LAYOUTS AND GRID LINES FOR “FACE OF CURBS AND BASELINE” 
One Grid layout Group is created in this exercise with 9 divisions per span. The first span needs to be 
modified since the number of divisions is equal to 7. 

The pictures depicted below were extracted from existing plans. 
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 Create Grid Layout for “Face of Curbs and Baseline” 

1. Select the grid Beams Span A thru C icon. 

2. Select the Create Grid tool. 

3. Name and Description Editor: Grid Group dialog appears. 

4. Enter name Face of Curbs and Baseline. 

5. Click OK to proceed. 

 Create Grid Lines for “Face of Curbs and Baseline” 

The grid layout Face of Rails and Baseline icon is automatically highlighted and the dialog 
remains expanded. Few changes are required here. 

1. Under the Grid Specifications group box, select None Selected from the Beam Layout 
pulldown list. 

Under the Grid Layout Data group box: 

2. Select Along Ref Alignment Between Piers from the Division of Span pulldown list. 

3. Enter Distribution 9. 

4. Select Both Pier Lines from the Pier pulldown list. 

5. Select No Bearing Lines from the Bearing pulldown list. 

6. Select Face of Curbs and Baseline icon from the Alignments pulldown list. 

 

7. Select the Modify Grid tool to update the changes. 

MODIFY A GRID LAYOUT WITHIN A SPAN 

 Modify Interior Grid Layout in Span A from Abutment A to Pier 1 

This exercise is to modify the second span Grid distribution by using the Use local Grid 
specifications at this span option. 

1. Select Face of Curbs and Baseline icon. 

2. Expand the Tree for this Grid.  Click the Plus Sign icon. 

3. Select the first span [Abutment A -> Pier 1] icon. 

4. Under the Grid Specifications group box, enable the Use local Grid specifications at this 
span option.  

5. Change Distribution to 7. 

6. Select the Modify Grid tool to update the changes. 
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CREATE REPORTS 
For more information refer to REPORTS in Chapter 1 or in the On-Line Help MicroStation: 
(Applications>GEOPAK>BRIDGE>Help) 

REPORTS MANAGER 
The Report Manager is used to manage the output of Text, CSV and XML files. It is also used to 
manage the updating, deleting, re-sequencing and displaying of reports. 

PROCEDURE 
Reports are created by using both the Properties Manager and the Reports Manager options. 

1. The Reports Manager is where output files are managed. 

2. The Properties Manager tool is where reports are activated and where Report Templates are 
selected. 

  Create a Report Set 

1. Select the Reports Manager tool from the GEOPAK Bridge tools palette. 

2. Select the Create Reports Set tool. 

3. The Name and Description Editor: Bridge Component dialog appears. Enter Name 
“University Blvd”. 

4. Click OK to proceed. 

5. Select the University Blvd icon. The dialog expands. 

6. Under the Report Output Modes group box, enable the Text File option. 

7. Select the Select Text File tool. The default directory appears. Under Files enter “Report”. 

 

8. Click OK to continue. 
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9. Select the Modify Reports Set tool to update the changes. 

10. Expand the University Blvd tree. Select the Text icon as shown below: 

Warning DO NOT CLOSE THE REPORTS MANAGER DIALOG.  We need to proceed with the 
Properties Manager to enable the reports properties. 

 

ACTIVATE REPORTS IN THE BRIDGE PROPERTIES 

 Activate Pier Lines Report 

1. Select the Properties Manager tool. 

2. Locate the Pier Lines icon in the tree. Under the Pier Lines icon select the Reports icon. 

 

3. Under the Reports window, select University Blvd from the Name pulldown list. 

4. Select Modify Report tool from the right side of the dialog. 



Activate Reports in the Bridge Properties 
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 Activate Grid Layouts Report 

1. Under the Grid Layouts icon select the Reports icon. 

 
Global Bridge Properties dialog shown 

2. Under the Reports window, select University Blvd from the Name pulldown list. 

3. Select Modify Report tool. 

 Activate Grid Heights Report 

1. Under the Grids Heights icon, select the Report icon. 

2. Select University Blvd from the Name pulldown list.  

3. Select Modify Report tool. 

 
Report activated for Grid Heights shown 

4. Close the Bridge Properties dialog. 

. 
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UPDATE REPORT 
When reports are activated in the Bridge Properties dialog, the Report Manager can process the report. 
You can display the report by selecting the Display Report tool. 

 Update Report 

1. Proceed to locate the Reports Manager dialog. 

2. Select the Update Report tool.  Wait for processing. 

Note The report is displayed automatically when the report generation is completed. 

The Grid report is partially shown below. 

 

 

 

The design file should appear as shown below. 

            
Partial Un-Rotated Plan view of Bridge shown 
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CREATE THE NORTH BOUND BRIDGE 

 Create a new Bridge “University Blvd North Bound” 

1. Select the Project Manager from the GEOPAK Bridge tools palette. 

 

2. Select the Create Bridge tool located in the right side of the dialog. 

3. The Name and Description Editor: Bridge dialog appears. Enter Name “University Blvd 
North Bound”. 

4. Click OK to proceed. 

5. Select the Project Explorer tool.  The GEOPAK Bridge-Project Explorer appears.  Select the 
One active bridge only option. 

 

 

Note This option allows you to switch between Bridges synchronizing all dialog boxes to the 
selected Bridge. 

6. Right Mouse-Click anywhere within the Bridge Tree list.  Select Bridge > University Blvd 
North Bound. 

7. Close the Project Manager and the Project Explorer dialog boxes. 
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 Create a Bridge Surface 

1. Select the Surface Manager tool from the GEOAPK Bridge tools pallete. 

2. Select the Surfaces Folder. The Surface Manager dialog expands. 

Under the Surface Data group box: 

3. Select GEOPAK Shapes (Job and Chain) from the Create By pulldown list. 

4. Click Browse and select directory C:\DATA\GEO\VDOT\BRIDGE\UNIVERSITY 
BLVD\ 

5. Select Job400. 

6. Select UBLVD from the Chain pulldown list. 

7. Right Mouse-click anywhere within the Bridge tree list. Select New> Item. 

8. The Name and Description Editor: Surface dialog appears. Enter Name “Road Shapes”. 

9. Click OK to proceed. 

10. Select the Display Z Levels tool, to browse elevations (Z Levels) of the selected surface. 

11. Close the Surface Levels and the Surface Manager Dialog boxes 

CREATE BRIDGE ALIGNMENTS NORTH BOUND 
From information shown in the cross section for this bridge, six alignments are created to define the 
Left Edge, the Right Edge, and the Baseline of the Bridge, the Right Face of Curb, Outside Face of 
Curb and the Left Face of Median Curb. 

 Create Bridge Alignment “University Blvd North Bound” (Bridge Baseline) 

1. Select the Bridge Location Manager tool. 

2. Select Alignments folder. The dialog expands. 

Under the Alignment Details group box: 

3. Select Offset from GEOPAK Chain from the Chain pulldown list. 

4. Click Browse and select directory C:\DATA\GEO\VDOT\BRIDGE\UNIVERSITY LVD\. 

5. Select Job400. 

Under the Horizontal group box: 

6. Select UBLVD from the Chain dropdown list. 

7. Enter Offset 0.00. 

Under the Bridge Limits group box: 

8. Select Indicate Start Limit tool. Indicate a Data Point just inside the beginning of the 
Shapes. 

9. Select Indicate Finish Limit tool.  Indicate a Data Point just inside the end of the Shapes. 

10. Under the Vertical group box, select Not used from the Profile dropdown list. 

11. Select the Create Alignment tool, from the right side of the dialog. 

12. The Name and Description Editor: Alignment dialog appears. Enter Name “University Blvd 
North Bound”. 

13. Click OK to proceed. 
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 Set Alignment as Baseline 

  

TOOL / OPTION DESCRIPTION 

 
Set alignment as Baseline 

 

1. Under the Alignments folder, select Alignment University Blvd North Bound. 

2. Select the Set alignment as Baseline tool. 

 Create Additional Bridge Alignments 

Create the rest of the Alignments using the information shown in the Table below. Change items in the 
dialog as required prior to creating the alignment. 

1. Under the Alignment Details group box, select Offset from Baseline from the Method 
pulldown list. 

2. Under the Horizontal group box, change the Offset as indicated in table below. 

3. Select the Create Alignment tool. 

4. The Name and Description Editor: Alignment dialog appears. 

5. Enter Name of Alignments are as Indicated in table below. 

6. Click OK to proceed. 

7. Repeat the same process to create the remaining alignments shown below. 

 

Create By Offset (+ or -) Alignment Name 

Offset from Baseline .0833 Left Edge of Deck 

Offset from Baseline 6.0 Left Face of Median Curb 

Offset from Baseline 33.0 Right Face of Curb 

Offset from Baseline 47.25 Right Edge of Deck 

Offset from Baseline 46.25 Outside Face of Curb 
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 Create Alignment List “Face of Curbs  and Baseline” 

This exercise is to create an Alignment List named Face of Curbs and Baseline. 

1. Select List (Alignments) icon. 

2. Anywhere within the dialog box, Right Mouse-click.  Select New > Item. 

3. The Name and Description Editor: List of Alignment dialog appears. 

4. Enter Name “Face of Curbs and Baseline”.  Click OK to proceed. 

5. Select the Face of Curbs and Baseline icon. 

6. Right Mouse-click anywhere within the dialog box,.  Select Lists > Add All. 

7. Expand the Tree for this List. Click the Plus Sign icon. 

8. Select Left Edge of Deck from the list. 

9. Select the Delete tool, to remove from the list. 

10. Select Right Edge of Deck from the list. 

11. Select the Delete tool, to remove from the list. 

 
Bridge Location Manager- Showing Created Alignments  
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CREATE PIER LINES 

 Create Pier Lines 

1. Select the Pier Lines folder. 

Create the Pier Lines using the information shown in the Table below. 

 

 Abutment A Pier 1 Pier 2 Abutment B 

Location Method Station and 
Skew Angle 

Station and 
Skew Angle 

Station and 
Skew Angle 

Station and 
Skew Angle 

Station 37+28.50 38+ 58.50 40+34.50 42+03.500 

Skew 0.0 0.0 0.0 0.0 

Bearing Line Data 
Back 

No Bearing Fixed Fixed Expansion 

Bearing Back 
Offset 

0.0 0.0 0.0 1.25 

Bearing Line Data 
Ahead  

Expansion No Bearing No Bearing No Bearing 

Bearing Ahead 
Offset 

1.25 0.0 0.0 0.0 

Pier Line Name Abutment  A 
Pier 1 Pier 2 Abutment  B 

Pier Description Face of 
Backwall - - Face of 

Backwall 

Under the Pier Line Location Data group box: 

2. Select the Station and Skew Angle from the Location Method pulldown list. 

3. Change Station value. 

Under the Bearing Line Data group box: 

4.  Change the Offset Back and Ahead. 

5. Right mouse-click anywhere within the Bridge tree list.  Select New > Item. 

6. The Name and Description Editor: Pier Line dialog appears. Enter Pier Name. 

7. Click OK to continue. 

Repeat steps above to create the additional pier lines. 
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CREATE GIRDER LAYOUTS AND GIRDER LINES FOR “GIRDERS SPAN A THROUGH C” 
The Girders are parallel to the baseline and are continuous. 

MODIFY THE DEFAULT REGULAR BEAM LINES NAMING PATTERN 
The default naming pattern is Beam {@}. In this exercise you need to change the pattern from Beam 
{@} to Girder {@}. 

 Change Pattern from Beam {@} to Girder {@} 

1. Select the Properties Manager from the GEOPAK Bridge tools palette. The GEOPAK 
Bridge-Properties Manager: [GLOBAL] appears. 

2. Under the Bridge Locations icon, select the Beam Layouts>Design icon. 

 

3. Under the Select Naming Category group box, select Regular Beam Lines from the Category 
pulldown list. 

 

4. Under the Select Naming Category group box, select Regular Beam Lines from the Category 
pulldown list. 

5. Under the Naming Pattern group box, Change from Beam {@} to Girder {@}. 

6. Close the Properties Manager dialog box. 
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CREATE GIRDER LAYOUTS FOR “GIRDERS SPAN A THROUGH C”   

 Create  Beam Layout for “Beams Span A through C” 

1. Select the Beam Layouts folder. 

2. Select the Create Beam Line tool. 

3. The Name and Description Editor: Beam Layout Group dialog appears. 

4. Enter Name “Girders, Span A through C”. 

5. Click OK to continue. 

CREATE GIRDER LINES FOR “GIRDERS SPANS A THROUGH C” 

 Define the First Beam 

1. Select beam layout Girders Span a through c. The dialog expands. 

Under the Beam Group Specifications group box: 

 

2. Enable the Continuous Beam Arrangement option. 

3. Select Concentric/Parallel from the Beam Geometry pulldown list. 

4. Select Abutment A from the Start Pier pull down. 

5. Select Abutment B from the End Pier pull down. 

6. Click First Beam tab to define the First Beam. 

7. Select Baseline Alignment from the Method pulldown list. 

8. Change Offset to 3.3333 ft. 



Create Girder Lines for “Girders Spans a through C” 
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 Define the Last Beam 

Under the Beam Group Specifications group box: 

 

1. Click Last Beam tab to define the Last Beam. 

2. Enable the Active option to define the Last Beam. 

3. Select Baseline Alignment from the Method pulldown list. 

4. Change the Offset to 44.0 ft. 

 Define the Beam Spacing 

Under the Beam Group Specifications group box: 

 

1. Click the Spacing tab to define the Beam Spacing. 

2. Select Number from the Method pulldown list. 

3. Enter 5 in the Number field. 

4. Select the Modify Beam Line tool to update the information. 
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RENAME THE NORTH BOUND GIRDER LINES 

 Rename the Girder Lines from A-C to E- I 

Under the Beam Layouts folder: 

1. Select the Design icon. 

 

2. Double Click on the Design icon. The GEOPAK Bridge properties dialog appears. 

3. Under the Select Naming Category group box, select Regular Beam Lines from the Category 
pulldown list. 

4. Under the Naming Pattern group box, change Girder {@} to Girder {E-I}. 

 

5. Close the GEOPAK Bridge Properties dialog.  The Bridge Naming tools appears. 

 

 

 

 

 

6. Select the Update Naming Sequence tool. The Bridge Naming Update dialog appears. 
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7. Select Raname all groups tool from the right side of the dialog. 

 

Note Notice that the Girder Lines are renamed accordingly. 

8. Close the Bridge Naming Update dialog box. 

 

CREATE GRID LAYOUT FOR “GIRDERS SPAN A THROUGH C” 

 Create Grid Layout for “Girders Span A thru C” 

1. Select the Grid Layouts folder. 

2. Select the Create Grid tool. 

3. Name and Description Editor: Grid Group dialog appears. 

4. Enter name Girders Span A through C. 

5. Click OK to proceed. 

CREATE GRID LINES FOR “GIRDERS SPAN A THROUGH C” 

 Create Grid Lines for “Girders Span A thru C” 

1. Select the Grid Layout Girders Span a thru c icon. The dialog expands. 

Under the Grid Specifications group box: 

2. Select Girders Span a through c icon from the Beam Layout pulldown list 

Under the Grid Layout Data group box: 

3. Select Parallel Back Pier from the Layout Method pulldown list. 

4. Select Along Ref Alignment-between Bearings from the Division of Span pulldown list. 

5. Select Along Grid Line from the Display Mode pulldown list. 

6. Enter Distribution 10 and select Fraction from the pulldown. 

7. Select No Pier Lines from the Pier Mode pulldown list. 

8. Select Both Bearing Lines from the Bearing Mode pulldown list. 

9. Select University Blvd North Bound from the Reference Alignment pulldown. 
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Under the Grid Specifications group box: 

10. Select None Selected from the Alignments pull down list. 

11. Select Road Shapes from the Elevation Surface pulldown list. 

12. Select None Selected from the Clearances Surface pull down list. 

13. Select the Modify Grid tool to update the changes. 

 

CREATE GRID LAYOUTS AND GRID LINES FOR “FACE OF CURBS AND BASELINE” 

 Create Grid Layout for “Face of Curbs and Baseline” 

1. Select the grid Girders Span A thru C icon. 

2. Select the Create Grid tool. 

3. Name and Description Editor: Grid Group dialog appears. 

4. Enter name Face of Curbs and Baseline. 

5. Click OK to proceed. 

 Create Grid Lines for “Face of Curbs and Baseline” 

The grid layout Face of Rails and Baseline icon is automatically highlighted and the dialog 
remains expanded. Few changes are required here. 

1. Under the Grid Specifications group box, select None Selected from the Beam Layout 
pulldown list. 

Under the Grid Layout Data group box: 

2. Select Along Ref Alignment Between Piers from the Division of Span pulldown list. 

3. Enter Distribution 9. 

4. Select Both Pier Lines from the Pier pulldown list. 

5. Select No Bearing Lines from the Bearing pulldown list. 

6. Select Face of Curbs and Baseline icon from the Alignments pulldown list. 

7. Select the Modify Grid tool to update the changes. 

MODIFY A GRID LAYOUT WITHIN A SPAN TO CHANGE THE DISTRIBUTION 

 Modify Interior Grid Layout in Span A from Abutment A to Pier 1 

This exercise is to modify the second span Grid distribution by using the Use local Grid 
specifications at this span option. 

1. Select Face of Curbs and Baseline icon. 

2. Expand the Tree for this Grid.  Click the Plus Sign icon. 

3. Select the first span [Abutment A -> Pier 1] icon. 

4. Under the Grid Specifications group box, enable the Use local Grid specifications at this 
span option. 

5. Change Distribution to 7. 

6. Select the Modify Grid tool to update the changes. 
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UPDATE REPORTS 
When reports are activated in the Bridge Properties dialog, the Report Manager can process the report. 
You can display the report by selecting the Display Report tool. 

 Update Report 

3. Proceed to locate the Reports Manager dialog. 

4. Select the Update Report tool.  Wait for processing. 

The report is displayed automatically when the report generation is completed 



Update Reports 
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